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1 Introduction  
Information that is stored on our disks can be much more valuable than the computer being used together 
with its software. –Then again, to what extent is something regarded as valuable? How much money would 
you ask for your favorite music collection, which you have been collecting your entire life? Or your disk 
may contain important financial data or results of scientific research. There are many things that are unique 
and therefore one has to be certain about security. 
 
Our program provides the user with the most reliable data protection for the hard disk – the ability to create 
archive duplications (i.e. backup images). By storing such an archive onto external media the user is able to 
restore the data at any time it is required. 
 
The second crucial function of the program is the ability to modify the hard disk structure. One day you 
realize that your hard drive cannot meet your requirements any more. Either its capacity is insufficient and it 
is time to think about a little upgrade, or you are to carry out some partitioning operations. Whatever the 
problem is, it requires solution. Our program provides a wide-range functionality in the field of managing 
disk layout structures. The key features of the program are listed in the special chapter. 
 
Setting up any operation is accomplished by using practical wizards. Each step of the wizard includes in-
depth information in order to allow the user to make the right choice. Graphical representations of the data 
help the user to gain a better understanding. 
 
In this manual you will find the answers to many of the technical questions which might arise while using 
the program. 
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2 Key Features  
Let us list some of the key features:  
  

 User friendly interface. Easily understood icons accompany all functions of the program. 
 Previewing the resulting layout of hard disks before actually executing operations (so-called virtual 

operations). 
 Backup an entire disk including service data of the file system.  
 Backup of dynamic disks. The user can back up all five types of dynamic volumes (simple, spanned, 

striped, mirrored, RAID-5). 
 Archive database helps the user to easily manage backup images (get properties, add, delete, mount, 

etc.). 
 Create and manage the backup capsule. This is a special secured place on the disk where backup 

archives are stored. 
 Start up the computer from the image contained in the backup capsule in case of the operating 

system corruption. 
 Restore an entire disk or separate files from the disk archive (image). 
 Restore with Shrink function provides the possibility to restore a backup image to a free block of 

smaller size taking into account only the amount of actual data of the image. 
 Copy Partition/Hard Disk Wizards that enable to successfully transfer all on-disk information 

including standard bootstrap code and other system service structures, thus maintaining the operating 
system’s working capability, and that even beginners may understand. 

 Easy-to-use One Button Copy Wizard provides a unique possibility to carry out such a technically 
complicated operation as cloning of hard disks just by pressing one button. 

 Basic functions for initializing, partitioning and formatting hard disks. Instead of the standard 
Windows disk tools, the program supports all file systems. 

 Recovering of any accidentally deleted partition by using the Undelete Partitions Wizard. 
 File Transfer Wizard assists the user with copying of separate files/directories or burning of them to 

CD/DVD. Besides it provides access to Paragon backups as regular folders to browse through their 
contents or copy required files. 

 Shutdown After Apply function enables to set the computer to automatically switch off on the 
successful accomplishment of any operation. 

 Volume Explorer utility allows the user to browse and export contents of the local 
mounted/unmounted volumes of any file system as well as Paragon backups. 

 Build external recovery media that help the user to restore the system even when the current 
operating system cannot boot anymore. 
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3 Installation  
This chapter provides information which is needed to perform the correct installation of the program, and in 
addition, checks if the current installation is working correctly.  

3.1 Package Contents  
The installation package includes the following components: 

 Launcher (with an embedded HTML browser)  
 Partition Management 
 Hard Disk Management 
 Copy Partition/ Hard Disk Wizards 
 Backup/Restore Wizards  
 Recovery Media Builder 
 Extra Functionality 

3.2 Minimum System Requirements  
To use the program on a computer satisfactorily, ensure that it meets the following minimum system 
requirements:  

 Operating systems: Windows NT Server/2000/XP/2003 Server/Vista and XP/2003/Vista 64-bit  
 Internet Explorer 5.0 or higher  
 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  
 128 MB of RAM  
 Hard disk drive with 40 MB of available space  
 SVGA video adapter and monitor  
 Mouse  

3.3 Installation Procedure 
The installation process consists of the following steps: 
 
1. Run Setup Application 
From the folder, where the setup files are kept, run the SETUP.EXE file. This application will guide the user 
through the process of the program installation. The setup utility is compiled with the InstallShield SDK, 
hence it contains the standard user interface and set of installation steps. 
 

 
In case there is some previous version of the program installed on the computer, the program 
will offer the user to uninstall it first. 

 
2. Starting Setup 
The Welcome page informs that the application is being installed. Click the Next button to continue. 
 
3. Confirm License Agreement 
The License Agreement page displays the Paragon License Agreement. Read the agreement and then click 
the Yes button to accept. If the user does not agree with any conditions stated there, the installation process 
will be interrupted. 
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4. Select an Installation Folder 
The Destination Location page allows the user to choose the folder where the program will be installed. By 
default, the installation folder will be created as: 
 
C:\Program Files\Paragon Software\Paragon Drive Backup. To select another folder, click the Browse 
button. 
 
After you have selected the required folder, click the Next button to continue. 
 

 
Do not install the program on network drives. Do not use Terminal Server sessions to install 
and run the program. In both cases, the program functionality will be limited 

 
5. Select a Program Group 
 
The Program Folder page enables the user to select the application's program group for the Start Menu. By 
default, it will be the program group: 
 
Start > Programs > Paragon Drive Backup. 
 
Click the Next button to continue. 
 
6. Verify Setup Settings 
 
The Start Copying page allows the user to verify settings, which have already been made and correct them if 
necessary. Press the Back button to return to the previous page and modify the installation settings. Click the 
Next button to complete the installation process. 
 
7. Copying Files 
 
The Setup Status page shows the overall progress of the installation. Click the Cancel button to abort the 
setup. 
 
8. Finishing the Installation 
 
The Final page reports the end of the setup process. 
 

 

To accomplish online backup/copy of locked partitions/hard disks the program uses a kernel 
mode hotcore driver, thus the system reboot is required to complete the installation 
procedure. 
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4 Basic Concepts  
This chapter explains terms and ideas that show how the program works. To understand these helps to obtain 
a general notion of the operation performance and makes it easier for the user to operate the program. 

4.1 Backup Operations  
Since the advent of the computer age the best way to protect valuable information was to store it in form of 
archives on external media. In case of hard disk malfunction, its contents could be restored from the archive. 
Then backup soon became a common term to mean making duplications of data for protection purposes. 
 
Nowadays backup has become an essential routine operation for any serious information work. A modern 
backup archive uses the so-called image, a snapshot of the whole disk system (or its separate partitions). It 
not only includes the contents of all user-made files, but additionally contains the exact structure of 
directories, information about file allocation, file attributes and other related data. A backup image can be 
copied or moved like any ordinary file. 
 
The user can store backup images on external media (CD/DVDs). This guarantees a high level of data 
protection as long as the backup media is kept secure. It is possible to store backup images on a local 
network drive as well. Special server-side software enables to secure and store backup images for the entire 
network. For this purpose computers named backup servers are used. Such a backup server provides nearly 
the same level of protection as external media. 
 
However, should the user not have a local network and/or it is inconvenient to record data onto external 
media, then the backup images can be stored in a specially secured place on the hard disk. This place is 
referred to as the backup capsule, which has an independent system layout (e.g. a separate partition) that will 
stay operable should the active file system be damaged. To avoid an accidental removing or unauthorized 
access of the backup data, this partition is hidden and thus cannot be mounted in the operating system. A 
single hard disk may contain only one backup capsule. However, the user can attach another hard disk with 
an existing backup capsule to the computer and restore from that as well without any problems. 
 
It is only possible to browse the contents of the backup capsule by using special software. The system of 
wizards that is implemented into the program is designed to work with the backup capsule. Thus, by storing 
disk images in the backup capsule the user obtains a reliable level of data protection. 
 
The above-mentioned methods of storing backup images are implemented in the program. And all the 
necessary actions are performed by using the system of convenient wizards. This means that the user simply 
has to follow easy step-by-step instructions to make the appropriate settings.  

4.2 Differential Backup 
As you probably know a regular backup image includes all contents of a partition. In case the user needs to 
create multiple backup archives of the same partition, unchanged data is duplicated in all archives and takes 
additional space on backup media.  
 
Our program enables to archive only changes in the partition’s contents with respect to a complete archive. 
The creation of a differential archive usually takes more time than the creation of an ordinary one. However, 
a differential archive requires much less space than the appropriate number of ordinary full archives or 
backup images, thus considerably saving your system resources.  
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Once the complete image of the partition is created, it can be used as a base or parental image for the 
differential backup. The program verifies whether the parental image corresponds to the partition being 
imaged or not. To distinguish between partitions, the program uses such partition's attributes as: location, 
capacity, file system type, and the serial number. 
 
The program performs the exact bit-wise comparison of the previous partition's data (saved in the parental 
image) with the current data (that is actually the partition itself). The difference in contents is saved in the 
new volume of differential backup archive. The volumes of the archive can be stored in different locations.  
  

 
This function is only available for single primary and logical partitions 

4.3 Paragon Hot Processing & Volume Shadow Copy Service 
4.3.1 Offline versus Online Backup 

In the course of time there have been developed various methods of backing up data. Despite different work 
concept, all of them can be divided into two principal groups: offline (cold) and online (hot) backup 
techniques. 
  
As the name infers, offline backup can only be accomplished when the data is in consistent state (the 
operating system and all the applications are completely shut down). Actually it is the most preferable way 
of image creation, since backup software obtains an exclusive right to process data that guaranties high level 
of operating efficiency. However an offline backup is absolutely out of question when dealing with 24/7 
production environments. 
  
In contrast, online backup enables to create a consistent snapshot even as the data is currently modified. 
Online backups are particularly useful for systems with high availability requirements, but they won’t be 
accomplished until all active transactions are complete. The point is to provide a coherent state of all open 
files and databases involved in a backup, taking into account that applications may still keep writing to 
disks. As a result an online backup cannot boast high operating speed. 
  
Our program supports both offline and online methods of image creation. As far as online backup is 
concerned it offers its own hot processing algorithm together with the possibility to use snapshot 
technologies provided by the Microsoft VSS framework. 

4.3.2 Paragon Hot Processing Technology 

Paragon Hot Processing is an online backup technology for Windows NT+ family operating systems. 
Developed back in 2001, nowadays it is integrated with all backup solutions offered by the company. 
  
Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During 
an online backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk 
write activity of applications and the operating system. The hotcore driver as an integral part of the program 
is installed during the setup procedure (that’s why the system reboot is required to complete the setup 
procedure). For the most part the driver is in the idle mode until it is activated with the program. While in 
this mode it bypasses any calls having no effect on the overall system performance, but a few kilobytes of 
the system memory. 
  
Paragon Hot Processing technology offers backup of locked partitions and hard disks under Windows NT+ 
family operating systems providing both high operating efficiency as well as low hardware requirements. 
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It is not recommended to use Paragon Hot Processing with active SQL Server 2003, 
Exchange 2003 or Oracle databases since the backup image contents may be corrupted. 

4.3.3 Volume Shadow Copy Service 

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the backup infrastructure for the 
Microsoft Windows XP/Server 2003 operating systems. It offers a reliable mechanism to create consistent 
point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the 
leading backup solution vendors on the market, it is based on a snapshot technology concept.  
  
Initiated by a VSS aware backup utility, VSS creates snapshots for the selected volumes and represents them 
as virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the backup 
utility starts processing the data while applications keep writing to original volumes. 
  
Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous 
snapshot of multiple volumes. This very feature can be particularly beneficial when backing up active SQL 
Server 2003, Exchange 2003 or Oracle databases located on multiple volumes the way it is recommended by 
Microsoft to improve the level of database performance and reliability, thus providing 100-percent data 
consistency. 
  

 
To use VSS it is necessary to have a mounted 300 MB+ NTFS partition. 

4.4 Dynamic Disks 
One of the key features of our program is the possibility to process dynamic disks. As you probably know, 
MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Server 2003/Vista support four primary partitions per 
physical hard disk, one of which can be extended. Certainly there is the possibility to create logical drives 
within the extended partition. Such types of disks are called basic. Windows XP Professional, Windows 
2000, Windows Server 2003 and Windows Vista follow the same strategy: You can have a maximum of 
four primary partitions, one of which can be an extended partition with logical drives. However, these 
operating systems also introduce a new disk configuration type - dynamic disk - which must be understood 
to effectively configure and manage hard disks. 
 
Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only 
dynamic volumes. Regardless of what format you use for the file system, only Win2K computers can access 
dynamic volumes directly. However, computers that aren't running Win2K can access the dynamic volumes 
remotely when connected to the shared folders over the network. 
 
Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix Basic 
and Dynamic disks on the same hard drive. 
 
There are five types of dynamic volumes: simple (uses free space from a single disk), spanned (created from 
free disk space that is linked together from multiple disks), striped (a volume the data of which is 
interleaved across two or more physical disks), mirrored (a fault-tolerant volume the data of which is 
duplicated on two physical disks, and RAID-5 volumes (a fault-tolerant volume the data of which is striped 
across an array of three or more disks). 
 
With dynamic storage, you can perform disk and volume management without the need to restart Windows. 
 
Limitations: 
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 Dynamic disks are not supported on portable computers. 
 Dynamic disks are not supported on Windows XP Home Edition-based computers. 
 You cannot create mirrored volumes or RAID-5 volumes on Windows XP Home Edition, Windows 

XP Professional, or Windows XP 64-Bit Edition-based computers. 
 
Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more 
management flexibility without the partition limitation of basic disks. Dynamic disks can contain an 
unlimited number of volumes, but they cannot contain partitions or logical drives. Dynamic storage can be 
particularly beneficial for large-scale businesses when dealing with many physical hard disks involving 
complex setup. 

4.5 64-bit Support 
The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end 
user. However that is not the case when dealing with servers processing large amounts of data with complex 
calculations of very large numbers. That is where 64-bit architecture comes into play.  
  
It can boast improved scalability for business applications that enables to support more customer databases 
and more simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such 
as memory allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses 
than a 32-bit processor. With these resources, even a very large database can be cached in memory.  
  
Although many business applications run without problems on 32-bit systems, others have grown so 
complex that they use up the 4 GB memory limitation of a 32-bit address space. With this large amount of 
data, fewer memory resources are available to meet memory needs. On a 64-bit server, most queries are able 
to perform in the buffers available to the database. 
  
Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For 
instance, system-level utilities and programs that provide direct hardware access are likely to fail. Our 
program offers a full-fledged support of the 64-bit architecture providing fault-tolerant work for such system 
dependent modules as Hot Processing. 

4.6 Copy Operations 
Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite 
advantages it can offer. First of all, many people clone hard disks just to back up data for security reasons. 
The present day copy utilities enable to successfully transfer all on-disk information including standard 
bootstrap code and other system service structures, thus maintaining the operating system’s working 
capability. In case of a system malfunction, the user can get the system back on track in minutes. No 
additional configuration is required, what is very convenient. 
  
The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard 
drive doubles every two years, thus opening up new possibilities for software developers. As a result 
programs become more complicated and require considerable amount of free space. One day the user 
realizes that there is no more free space left on the hard disk and the only way out is to upgrade. Usually that 
means that besides purchasing a new hard disk, the user is to face a large re-installation procedure spanning 
several days of tedious work. But all of this can be avoided just by copying the contents of the old hard disk 
to a new one proportionally resizing the partitions. 
  
And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when 
setting up similar computers. There is no need for a system administrator to install an operating system from 
scratch on every one of them. It is enough just to configure one and then clone it to the others. 
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5 Interface Overview  
This chapter introduces the graphical interface of the program to the user. The design of the interface 
precludes any mistake being made on the part of the user. Most operations are performed through the system 
of wizards. Buttons and menus are accompanied by easy understandable icons. Nevertheless, any problems 
that might occur while managing the program can be tackled by reading this very chapter. 

5.1 General Layout  
When the user starts the program, the first component that is displayed is called the Launcher. It enables the 
user to run wizards and utilities, to specify program settings, to visualize the operating environment and the 
hard disk configuration. 

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and 
functionality: 

1. Main Menu  
2. Tool Bar  
3. Virtual Operations Bar  
4. Common Tasks Bar  
5. Explorer Bar  
6. Disk Map  
7. Legend Bar 
8. Status Bar  
  
Some of the panels have similar functionality with a synchronized layout. The program enables the user to 
conceal some of the panels to simplify the interface management. 
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All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the 
screen layout. 

5.2 Main Menu  
The Main Menu provides access to the entire functionality of the program. The available functions are as 
listed below: 

MENU ITEM  FUNCTIONALITY  
Tools     
Generate Script… Generate a script for the task 
Send Log Files Compress and send the log to the Paragon Support Team 

Recovery Media Builder… Restore the system even when the current operating system cannot boot 
anymore 

Check Recovery Disks… Verify the recovery media for integrity and ability to boot from 
Settings... Edit the general settings of the program  
Exit  Exit the program  
Changes   
Undo "the last virtual 
operation" Cancel the last virtual operation on the List of Pending Operations 

Redo "the last virtual 
operation" Cancel the last undo virtual operation on the List of Pending Operations 

View Changes… Display the List of Pending Operations 
Apply Changes Launch the real execution of virtual operations 
Discard All Changes Cancel all virtual operations on the List of Pending Operations 
Reload Disk Info  Refresh the current information about disks  
Wizards    
Back Up Disk or 
Partition…  Create a new backup archive  

Differential Backup… Create a differential backup of the selected partition 
Restore Disk or Partition…  Restore a disk from the backup image  
Manage Backup Capsule… Create or manage a backup capsule  

Synthetic Backup…
Synthesize a new property modified archive based on the existed backup 
image (splitting, password protection, compression level, etc.) as well as 
rearrange its location 

Check Archive Integrity… Perform integrity check for the required backup image 
One Button Copy Wizard  Create a hard disk copy just by pressing one button 
Copy Hard Disk…  Create a hard disk copy  
Copy Partition…  Create a partition copy 
Undelete Partitions… Recover any of accidentally deleted partition 
Hard Disk  
Back Up Hard Disk… Create a new backup archive of the selected hard disk 
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Burn Hard Disk to CD or 
DVD… Back up and burn the selected hard disk to CD/DVD 

Restore Hard Disk… Restore the selected hard disk from a backup image 
Update MBR Update MBR (Master Boot Record) of the selected hard disk 
Change Primary Slots… Modify the primary partitions enumeration for the selected hard disk 
Convert to Basic… Convert a dynamic disk containing simple volume(s) into basic 
Change SID… Change SID (Security Identifier) value of any found Windows installation 
Edit/View Sectors… View/edit sectors of the selected hard disk 
Properties… Get in-depth information on the properties of selected hard disk 
Partition  
Create Partition… Create a partition of any file system with the Create Partition dialog 
Format Partition… Format a partition of any file system Format Partition dialog 
Delete Partition… Delete a partition of any file system Delete Partition dialog 
Back Up Partition… Create a new backup archive of the selected partition 
Burn Partition to CD or 
DVD… Back up and burn the selected partition to CD/DVD 

Restore Partition… Restore the selected partition from a backup image 
Assign Drive Letter… Assign drive letter to the selected partition 
Remove Drive Letter… Remove drive letter for the selected partition 
Hide Partition… Make the selected partition unavailable for the operating system 
Unhide Partition… Make the selected partition available for the operating system 
Mark Partition as Active Make the selected partition bootable by default 
Mark Partition as Inactive Make the selected partition non-bootable by default 
Change Volume Label… Change volume label of the selected partition 
Change Serial Number… Change serial number of the selected partition 
Change Partition ID… Change identifier of the selected partition 

Clear Free Space… Destroy any remnants of deleted files/directories left on disk without affecting 
the used data 

Test Surface… Test surface of the selected partition/block of free space 
Check File System 
Integrity… Check the selected partition for possible file system errors 

Edit/View Sectors… View/edit sectors of the selected partition 
Properties… Get in-depth information on the properties of selected partition 
Archives  
Add an Archive to the 
Database… Add a backup image to the Archive database 

Delete the Archive from 
the Database… Remove the selected backup image from the Archive database 

Restore from the Selected 
Archive…  Restore a disk from the selected backup image 

Check Archive Integrity… Perform integrity check for the required backup image 
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Differential Backup… Create a differential backup of the selected partition 

Synthetic Backup…
Synthesize a new property modified archive based on the existed backup 
image (splitting, password protection, compression level, etc.) as well as 
rearrange its location 

Mount the Selected 
Archive… Assign drive letter to the selected backup image 

Unmount the Selected 
Archive… Remove drive letter for the selected backup image 

View     

Toolbar  Manage the Tool Bar representation: show / hide standard and navigation 
buttons, text labels and large icons.  

Status Bar  Display the Status bar  
Common Tasks Bar  Display the Common tasks bar  
Disk Map Legend Display the Disk map legend 

Disk Map Location  Select whether the Disk map will be located on the top of the main window or 
at the bottom  

Help     
Help  Open the Help system  
About  Open the dialog with information about the program  
 

 
The Main Menu contents available at the moment may vary depending on the selected object. 

5.3 Tool Bar  
The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY  

 
Create a new backup archive  

 
Restore a disk from the 
backup image  

 
Copy a hard disk 

 
Copy a partition 

 
Open the Help system  

5.4 Virtual Operations Bar  
The program supports previewing the resulting layout of hard disks before actually executing operations (so-
called virtual mode of execution). In fact, when the virtual mode is enabled, the program does not 
accomplish operations immediately, but places them on the List of Pending Operations for later 
accomplishment. 
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The Virtual Operations Bar enables to manage pending operations. 
  
BUTTON FUNCTIONALITY  

 
Cancel the last virtual operation on the List 
of Pending Operations 

 
Cancel the last undo virtual operation on 
the List of Pending Operations 

 Display the List of Pending Operations 

 
Launch the real execution of virtual 
operations 

 
Cancel all virtual operations on the List of 
Pending Operations 

  

 

Virtual mode is an effective way of protection from any troubles, since no operations will be 
executed until clicking the Apply button for confirmation, thus giving a second chance to 
weigh all pros and cons of this or that particular operation. The program politely reminds the 
user that there are unsaved changes by showing the following window: 

 

5.5 Common Tasks Bar  
The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the 
program's wizards that provide all the functionality needed to manage copy operations. 

The bar contains four tabs named Backup/Restore Tasks, Copy Tasks, Tools and News and Documentation. 
Each of these contains a separate button bar which can be folded by clicking it. 

Backup/Restore Tasks     
Starting the Backup Wizard. The Backup Wizard assists the user with the 
backup of the hard disk’s data. 

Starting the Differential Backup Wizard. The Differential Backup Wizard 
enables to create a differential backup of a partition. 

Starting the Restore Wizard. The Restore Wizard helps to restore data 
from a previously made backup image. 

Starting the Manage Backup Capsule Wizard. The Manage Backup 
Capsule Wizard helps to create, resize or delete the backup capsule. 
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Copy Tasks    
Starting the One Button Copy Wizard. The One Button Copy Wizard 
assists the user with cloning of hard disks just by pressing one button. 

Starting the Copy Hard Disk Wizard that helps to make an exact copy of a 
hard disk. 

Starting the Copy Partition Wizard that helps to make an exact copy of a 
partition. 

Tools   

Starting the Recovery Media Wizard. The Recovery Media Wizard helps 
to create media which can be used for recovery purposes. 

Starting the Check Recovery Disk Wizard. The Check Recovery Disk 
Wizard assists the user with verifying the recovery media for integrity and 
ability to boot from. 

Starting the Check Archive Integrity Wizard. The Check Archive Integrity 
Wizard helps to verify whether the backup archive is valid or not. 

Starting the Synthetic Backup Wizard. The Synthetic Backup Wizard 
enables to synthesize a new property modified archive based on the 
existed backup images (splitting, password protection, compression level, 
etc.) as well as rearrange its location. 

Starting the File Transfer Wizard. The File Transfer Wizard allows 
copying of separate files/directories or burning of them to CD/DVD. 
Besides it provides access to Paragon backups as regular folders to browse 
through their contents or copy required files. 

News and Documentation     

Launching the Help system.  

Opening the page which contains information about the program. This 
page will be displayed in the Explorer bar. 

Opening a brief review on the Paragon Scripting Language. 

5.6 Disk Map  
The Disk Map is displayed in the Explorer bar when the Disk View tab is selected. It is located either at the 
top or at the bottom of the window, depending on the state of the Disk Map Location option (Main menu: 
View > Disk Map Location). The user can change the current location of the map with this option. 
  
As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are 
represented with rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. 
Their color depends on the file system of the appropriate partition. 
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Large-sized bars display the following information about physical disks: 

 Manufacturer, 
 Model. 

  
Small-sized bars display the following information about logical disks: 

 Serial number, 
 Drive letter, 
 Total size, 
 File system. 

  
Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. 
  
Disk Map is synchronized with the Explorer bar. When the user selects a disk on the Disk Map the Explorer 
bar displays detailed information of the selected disk. 
  

 

The user can click a large-sized bar to display information about the appropriate physical 
disk in the Explorer bar. A click on a small-sized bar will lead to displaying information 
about the appropriate logical disk. 

5.7 Explorer Bar 
The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar 
displays reference information including: 
  

 User Manual, 
 Information about the program consisting of the product's name, the version of the program and a list 

of helpful links, 
 Detailed information about disks selected on the Disk Map, 
 List of archives, 
 Volume Explorer utility. 

  
According to these categories the Explorer bar has several tabs: 
  

 Disk View, which offers the user the following options: 
- Volume Explorer to browse and export contents of the selected partition/hard disk; 
- Properties to view detailed information on the selected partition/hard disk in the bright graphical 
form. 

 Archives, which enables to manage the Archive database. 
 Help System, which contains the User Manual and information about the program. 

  
The user is able to access the desired information by clicking on the appropriate tab. 
  
The Explorer Bar is a fully-functional embedded HTML browser, which enables the user to address, for 
example, our company's website to look through important technical notes or download the latest updates 
without having to close the program. The Help System of the program is HTML-oriented. The user can read 
the user manual and follow external links from to get additional information. 
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To easily navigate through browsed pages, the program provides the following functionality: 
  
BUTTON FUNCTIONALITY  

 
Return to the previously browsed 
page  

 Open the next browsed page  

 Stop loading the current page  

 
Refresh the contents of the current 
page  

5.8 Legend Bar 
The Legend Bar explains the color scheme used for disk and partition presentation. The user can hide (or 
show) the bar with the appropriate Main menu item: View > Disk Map Legend. When it is activated it can be 
found at the bottom of the Explorer bar.  
  
The program distinguishes between the following types of known file systems: 
  
   - FAT16/32,  
   - NTFS, 
   - Linux Ext2/3,  
   - Linux ReiserFS. 

5.9 Status Bar  
This is the bottom part of the main window. The status bar displays menu hints, for each item the cursor 
points to. 
  
The user can hide (or show) the bar with the appropriate Main menu item: View > Status bar. 
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6 Settings Overview 
The Settings dialog is available from the Main menu: Tools > Settings. All the settings are grouped into 
several sections of which the functions are described in the following paragraphs. The list of sections is 
placed on the left side of the dialog. By selecting a section from the list, the user opens a set of options. 

6.1 General Options  

 
 
This section contains a set of general options that will be taken into account during all the operations carried 
out with the program. The user can switch between the following modes: 

 Verify data written. If this option is marked, every write-to-disk action is followed by the 
read-and-compare action. This feature may be helpful in case of running an unstable hard 
disk, however it will negatively affect the overall performance. 

 Enable data loss protection. Activate the option to force the program to work in the fail-safe 
mode (also referred to as data-loss protection mode), which ensures more safety for 
operations by maintaining the special journal of operations’ progress. In case of hardware 
malfunction, power outages or operating system failure, the modified partition may become 
corrupted and non-operable. However, the program will be able to complete the interrupted 
operation, thus "reviving" the partition. 

If the system has crashed during the operation in the fail-safe mode, insert the bootable 
Recovery CD and restart the computer. The program will automatically detect the journal of 
the interrupted operation and complete the operation. 

 
It is strongly recommended to enable this option. 
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 Try to access non-BIOS disk cylinders. The option works only under Windows 95, 98, ME. 
When activated, the program performs a special procedure to define the disk capacity and 
does not use the value that is returned by BIOS. 

6.2 Backup Image Options  

 
 
This section contains a set of options that will be taken into account during the creating backup images and 
restoring disks from them. The user can activate the following modes: 
  

 Controlling archive integrity, 
 

 

Checking archive integrity enables to guarantee that all backup images created with the 
program are 100 percent flawless. Nevertheless if you decided not to control the archive 
integrity, the backup operation would take about 3-5% less time. 

 
 Automatic setting file names in case of complex archives, 
 Splitting images to several files, 
 Compressing a backup image. The user can also define the compression level. 

6.3 General Copy and Backup Options  
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This section contains a set of options that will be taken into account during copy and backup operations. The 
user can switch between the following modes: 
  

 HDD raw processing. Activate the option to copy a hard disk in the sector-by-sector mode to 
successfully process unknown file systems. However it is not recommended to enable this option 
when working with supported file systems as it takes more time to accomplish the operation. 

 Partition raw processing. Activate the option to copy a partition in the sector-by-sector mode to 
successfully process unknown file systems. However it is not recommended to enable this option 
when working with supported file systems as it takes more time to accomplish the operation. 

 Perform incremental copy. Once the complete copy of a hard disk is created, it can be used as a 
base for the incremental copy. Mark the option to make the program perform the exact bit-wise 
comparison of the previous data (saved in the parental copy) with the current data (that is actually the 
hard disk itself). After that only most recent information will be processed. It considerably decreases 
the amount of data written. 

 Skipping OS auxiliary files during backup operation. 
 Skipping archives stored in the archive database. If this option is marked, all backup images 

stored in the archive database will not be processed during the backup operation. It will considerably 
decrease the resulted image file and time to carry out the operation. 

  
In order to activate an option the user should mark the appropriate checkbox.  

6.4 CD/DVD Recording Options  
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This section contains a set of options that will be taken into account during the CD/DVD burning operation. 
The user can define: 
  

 Recording speed 
 Folder where the ISO image is to be placed. 

6.5 Hot Processing Options  
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This section contains a set of options that will be taken into account in case the Hot Processing mode is 
enabled. The Hot Processing mode is a part of the backup/copy operation that allows the program to process 
a disk without restarting the computer. The program forces the system to restart to obtain exclusive access to 
the processing data. The Hot Processing mode may be used to process locked partitions or any backup/copy 
operation. The user defines the method in this section. 
 
The user can also set a Temporary drive. This option defines a partition (by default – C:) for the Hot 
Processing temporary file. The temporary file will be deleted when the hot backup/copy is performed which 
may require a large amount of disk space. Should there not be enough space on drive C:, then another drive 
needs to be selected. 

6.6 Partitioning Options 
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This section contains a set of options that will be taken into account during partitioning operations. The user 
can activate the following modes: 
  

 64 KB cluster size for FAT16 partitions. Only Windows NT 4.0/2000/XP/2003 support 64 KB 
clusters. 

 Request confirmation before partition deletion. 
 Request confirmation when converting FAT16 to FAT32 during such partitioning operations as 

copy disk/partition, restore disk/partition. 
 Surface test level. The option affects the following operations: format partition, copy partition, 

restore partition, retest the surface. While performing the surface test, the program detects corrupted 
sectors and marks them as unusable. 

6.7 E-Mail Options 
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This section contains a set of options that will be taken into account during the Send log files and Send e-
mail notification operations. The user can define: 
  

 Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to 
have access to a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing 
messages are first sent to the SMTP server, which in its turn delivers them to the required recipients. 
The address may be represented as a traditional Internet host name (e.g.: mail.com) or as an IP 
numeric address (e.g. xxx.xxx.xxx.xx). 

 User e-mail address. Specify an e-mail address that has been assigned by the Internet Service 
Provider or organization's e-mail administrator. 

 My outgoing server requires authentication. Activate the option to allow the program to make 
authentication on the server before sending messages. 
- User name. Enter the name that will be used to log in to the e-mail account. 
- Password. Enter the password that will be used to access the mail server. 

6.8 Run during Backup Options 
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This section allows the user to specify external applications to execute at various phases of backup. It can be 
particularly useful when imaging systems with high availability requirements (MS SQL, MS Exchange, 
etc.), since it enables to create a consistent snapshot even as the data is currently modified. The point is to 
provide a coherent state of all open files and databases involved in a backup, taking into account that 
applications may still keep writing to disks. 
  
Actually the backup process consists of two phases: the preparation phase (snapshot) and the data-copying 
phase. There are three points of backup when external commands/programs can be launched: 
  

 Execute at the beginning of the backup process before taking a snapshot. This option enables to 
prepare running applications for the backup process. Specific commands/programs to use depend on 
the particular application. It may be deletion of unnecessary files, services suspension, transactions 
or cashes flush, etc. 

  
 Execute after taking a snapshot. Here the user can specify commands/programs to execute just 

after taking a snapshot. They also depend on the particular application and may include resuming of 
previously suspended services. 

  
 Execute after finishing the backup process. Commands/programs defined in this option will 

execute just after the backup process is completed and may include those that move the backup 
archive to some particular location. 

  
By clicking the Browse button the user can get into the browser-like window to choose a file of the required 
commands/programs. 
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The program provides the ability to work with three types of executable files (.exe, .bat, .cmd). It is up to 
the user to write batch files to safely prepare applications for backup. There are some certain general 
requirements for that:  
  

 All programs and commands must execute sequentially and finish before the .bat file completes its 
work. 

  
 It is recommended to use external commands/programs in the following format - Start /wait  

program.exe 
  

 

This function is only available when the Hot Processing mode is enabled. 
  
The current version of the program allows the user to set parameters for executable files 
directly from the line. However if the path to the file contains word gaps it is necessary to 
enclose it in quotes in order to make the program distinguish between path and used 
parameters. 
  
The wait option enables to start an application and wait until it completes its work. This will 
guarantee that all included commands/programs complete their execution before the batch 
file does. 

6.9 Virtual Mode Options 
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 Allow virtual mode. In this section the user can choose whether to allow operations to carry out 
immediately or to place them on the List of Pending Operations for later execution. Just mark the 
option to enable virtual operations. 

 Close progress dialog automatically. Mark the option to automatically close the progress dialog 
when the required operation(s) is completed. 

  

 
Virtual mode can be particularly beneficial for such operations as Generate script… 
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7 How to Protect Data  
This chapter lists various scenarios of data protection which may be accomplished by the program. This has 
already been reviewed in the Basic concepts chapter. Here the user will find more useful recommendations 
and descriptions of operations.  

7.1 Getting Information about Disks and their Images  
To begin with, let us examine the current situation of the available disk space. We look at the properties of 
our disks or peculiarities of existing backup images. The program provides some helpful tools for this 
purpose.  

7.1.1 Viewing Disk Properties  

The user is able to view in-depth information on the properties of hard disks. The main tool to extract this 
information is the Disk Map. It represents the actual state of the computer’s hard disks. The Disk Map 
chapter is a detailed description on this topic. 
 
Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized 
bars. The small-sized bars represent logical disks (partitions). When the user selects a large-sized bar, the 
Explorer bar displays information about the disk in a bright, graphical form.  
 

 
 
The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in 
form of a circular graph, where the color of a sector corresponds to a file system of an appropriate partition. 
On the right the user may see a table, which contains the following information: 
  

 Type of hard disk (basic or dynamic), 
 Total size (in GB), 
 Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

  
Below there is a list of wizards available for the user. If the user clicks a corresponding record the 
appropriate wizard will be started. All default values for the operation parameters will correspond to the 
disk’s settings. The list of wizards contains a detailed description of tasks that can be performed by the 
wizard. This nullifies the possibility of selecting the wrong wizard. 
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When the user selects a small-sized bar (i.e. corresponding to a logical disk), the Explorer bar will display 
information on it as well. The page title will contain a drive letter, which is assigned to the disk. The disk 
layout graph will be colored in accordance with the volume ratio of the used space to the free space (the 
light colored sector). The table on the right will contain the following information: 
  

 Volume label (if available), 
 Type of the logical disk, 
 File system (represented by the color of the graph and the selected bar), 
 Total size, used space and free space (in GB or MB). 

  
Below there is a list of wizards, which may be called for this disk. All default values of parameters will 
correspond to the disk settings.  

7.1.2 Viewing Image Properties  

Before restoring a disk from an image it is necessary to be sure that it is the image you need. General 
information on backup archives can be obtained either with the help of the Restore wizard or the Archive 
database:  

7.1.2.1 Using the Restore wizard  
There are several ways to launch the Restore Wizard: 
  

 In the Main menu: select Wizards > Restore Disk or Partition… 
 In Common Tasks bar: click the Restore hard disks or partitions item of the Wizards menu 
 Select a logical disk and then click the Restore the disk from an image link on the Explorer bar page. 

  
At first, the wizard displays the Welcome page – simply click the Next button at the foot of the dialog 
window. 
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The next page refers to Browse for Archive. By clicking the Switch to Archive List View link, the user can 
see the list of images contained in the Archive database (if any). To get a clear-cut picture on properties of 
the required image, just click on it and the section below will (i.e. Archive File Details) display a short 
description, including: 
  

 information on a type of the archive contents (whether it contains the entire disk or just a partition), 
 whether the archive is compressed or not, 
 whether the archive is password protected or not, 
 the date, when the archive was created. 

  
In addition, there are some special graphical flags to indicate crucial properties: 
  
FLAG  FUNCTIONALITY  

 System archive 

 Encrypted archive 

 Compressed archive 

 Differential archive 
  
To easily manage images in the Archive database, the program provides the following functionality: 
  
BUTTON FUNCTIONALITY  

 Refresh the contents of the database 

 Show only existing archives  

 
Add the selected archive to the 
database  

 
Delete the selected archive from the 
database 

  
Besides, the user may differentiate images of partitions or hard disks by setting up the filter in the left top 
corner of the page. 
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By clicking the Switch to File View link, the user can find the required image in the browser-like window. 
The section below (i.e. Archive File Details) displays a short description of the selected image, including: 
  

 information on a type of the archive contents (whether it contains the entire disk or just a partition), 
 whether the archive is compressed or not, 
 whether the archive is password protected or not, 
 the date, when the archive was created. 

  
Moreover, on this page the user has the possibility to create new folders, delete existing files/folders or map 
network drives by clicking the appropriate buttons. 
  

 
 
The next page (i.e. What to restore) displays detailed information about the contents of the archive. It 
includes a full description of properties about the archived disks or partitions. 
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If you want to restore the contents of the image click the Next button. In order to cancel, click the Cancel 
button. 

7.1.2.2 Using the Archive database 
To open the Archive database the user should click the appropriate tab in the Explorer Bar. The database 
window can be conditionally subdivided into several sections that differ in their purpose and functionality: 
  

 
1. Explorer bar that displays properties of the selected image 
2. Volume Explorer that enables to access the selected image as a 
regular folder to explorer its contents or to retrieve certain files 
3. Archive list that displays the list of images contained in the Archive 
database (if any). Besides the program provides all the necessary 
functionality to manage backup images in the database (add, delete, 
mount, refresh, etc.) 
  

 
All panels offer a synchronized layout and are separated by vertical and horizontal 
expandable sliders, allowing the user to customize the screen layout. 

7.1.3 Viewing Image Contents  

The user may browse the contents of the archives with a special utility called Volume Explorer. To launch 
the Volume Explorer the user should click the Disk View tab in the Explorer Bar and then choose Volume 
Explorer. 
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In order to view contents of an archive, open it by double click of the left mouse button. 
 
Volume Explorer also provides the possibility to extract separate files and folders from archives without 
restoring the whole archive. 
 
Volume Explorer can work with any kinds of archives created by the program. For example, it can browse 
the Backup Capsule which is hidden from any standard Windows program. 

7.2 Backup a Disk  
In the Basic concepts chapter we mentioned that the most prevalent way to protect valuable data is to create 
backup copies (backup images in terms of the program) of it. To meet the requirements of any user this 
operation can be accomplished either with the Backup Wizard or through the corresponding dialog.  

7.2.1 Starting Wizard 

There are several ways to start the Backup Wizard: 
  

 In the Main menu: select Wizards > Back Up Disk or Partition… 
 On the Common Tasks bar: click the Backup hard disks or selected partitions item of the Wizards 

menu. 
 In the Toolbar: click the Back Up button. 
 Select a disk on the Disk map and click the Create the image of the logical disk item on the page that 

appears in the Explorer bar (when the user selects an entire hard disk on the Disk map the item is 
named Create the image of the entire disk). 
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Copyri

After following one of the above mentioned actions, the Welcome page of the wizard is displayed. 
 

 

7.2.2 Starting Dialog 

In order to start the operation the user should take the following steps: 
 
1. Select a hard disk/partition on the Disk Map or on the List of Partitions. 
 
2. Call the Back Up Hard Disk/Partition dialog to define appropriate settings: 

 
 In the Main menu: select Hard Disk/Partition > Back Up Hard Disk or Partition… 
 Call the popup menu for the selected hard disk/partition (right click of the mouse button) on the Disk 

Map, then select the menu item: Back Up Hard Disk or Partition… 

7.2.3 Settings  

Despite different work algorithms, both the Backup Wizard and the Back Up Hard Disk/Partition dialog 
provide the same level of functionality, thus let us just take as an example the wizard version of the 
operation. Here the user sets the parameters of the backup operation defining: 
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 The object to back up. The user can backup either an entire disk or separate partitions of the 
disk (primary, extended or logical). In case of backing up an entire disk, the user has the 
possibility to include into the image such disk elements as the Master Boot Record (MBR) 
and the first track of the hard disk. This can be very helpful for serious disk recovery 
procedures. 
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 Backup destination. The Backup Wizard allows saving backup archives to local or network 
drives, to physical partitions (without drive letters assigned), or burning them to CD/DVDs. It 
is also possible to place the archives in the Backup Capsule. The user needs to select a 
destination, taking the estimated archive size and available space on the backup destination 
into account. 

 

 
To use the Backup Capsule as a backup destination, first create it with the Manage Backup 
Capsule Wizard. 

 Name and location of the resulted image. Provide a file name for the new image and its 
exact location. The program automatically offers an easy to understand name containing the 
date and the time of the archive creation, which can anyway be modified. 

 

 
The program automatically calculates size of the future archive and informs the user about 
space available on the selected destination.  

 Archive Comment. The user can add some additional description to the archive that will 
later help to distinguish it from the others. 

 

In addition, there is the possibility to make further detailed settings (although the default values will do in 
most cases). To activate the advance mode, the user needs to mark the appropriate option on the second page 
of the wizard (i.e. the What to back up page). The checkbox is to be found at the foot of the page 

. When it is marked, the next page allows the user to define: 
 

 Whether the archive integrity will be controlled. 
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Checking archive integrity enables to guarantee that all backup images created with the 
program are 100 percent flawless. Nevertheless if you decided not to control the archive 
integrity, the backup operation would take about 3-5% less time. 

 
 Whether image file names will be set automatically in complex archives. 
 Compression level for the backup image (including the No compression variant). 
 Whether the archive will be split (if this is the case the user can set the maximum size for the archive 

files). 
 

 
Splitting images enables to tackle issues caused by a file size limitation of some file systems. 

 
 Whether the archive will be protected by password. 
 Whether the selected disk (or the selected partition) will be copied in the sector-to-sector mode 

(including unused sectors as well). 
 Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be included in the backup image. 
 Recording speed when the user wants to burn the backup image onto CD/DVDs. 
 ISO image folder where the archive that is to be recorded on a disc, is placed. 
 Whether the operation will be performed without rebooting the system. The program needs to 

reboot the system in order to have exclusive access to processing data. In a Windows environment 
this is difficult to achieve because even when all the other applications are closed, the system service 
programs are still running. However, there is a way to avoid rebooting. The mode of processing the 
backup operation without rebooting is named Hot Processing. The user is also able to define specific 
parameters for the Hot Processing mode. 

7.2.4 Results  

Depending on the user’s choice the Backup wizard: 
  

 starts the backup operation 
 or records the planned actions in form of a script.  

  
After the backup operation is completed the user receives an image of the selected disk (or the selected 
partition). This image is placed into the specified destination (a local or network disk, the Backup Capsule, 
or a CD/DVD disc), its features defined by the wizard. 
 

 
The program allows the user to back up all five types of dynamic volumes (simple, spanned, 
striped, mirrored, RAID-5). 

7.3 Differential Backup 
To update the image of the selected partition with the Differential Backup Wizard, simply do the following: 

1. On the Common Tasks bar click the Differential Backup item of the Wizards menu. 
 
2. On the Differential Backup Wizard's Welcome page, click the Next button. 
 
3. On the Browse for Archive page, select the required base archive in the browser-like 
window. The Archive File Details section displays a short description of the selected image. 
Click the Next button.  
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4. The Archive Content page displays detailed information about the contents of the archive. 
It includes a full description of properties about the partition. In addition, there is the 
possibility to modify backup settings. To activate the advance mode, the user needs to mark 
the appropriate option at the foot of the page. Click the Next button. 
 
5. On the Backup Destination page, select the necessary operation: 

 Save data to local/network drives 
 Save data to physical partitions 
 Burn the data to CD/DVD 

Click the Next button.  
6. Add comments to the backup describing its contents.  
7. Select how to perform the operation: 

 immediately (the Back up now option) 
 or generate a script in accordance with the entered settings 

Click the Next button. 

After the operation is completed the user receives differential backup of the selected partition. It is placed 
into the specified destination (a local or network disk, or a CD/DVD disc), its features defined by the 
wizard.  

7.4 Backup a Dynamic Disk  
To back up a dynamic disk with the Backup Wizard, simply do the following: 

1. Click the Back Up button in the Tool bar (any of the ways described earlier can also be 
used here to call the Backup Wizard). 
 
2. On the Backup Wizard's Welcome page, click the Next button. 
 
3. On the What to back up page, mark the appropriate option opposite a dynamic disk. 
There is no need to mark all the constituents of the dynamic volume, the program will do it 
automatically: 
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Click the Next button. 
 
4. On the Backup Destination page, select the necessary operation: 

 Save data to local/network drives 
 Save data to physical partitions 
 Burn the data to CD/DVD 

Click the Next button.  
 
5. Add comments to the backup describing its contents.  
 
6. Select how to perform the operation: 

 immediately (the Back up now option) 
 or generate a script in accordance with the entered settings 

Click the Next button. 

 
The program allows the user to back up all five types of dynamic volumes (simple, spanned, 
striped, mirrored, RAID-5). 

7.5 Synthetic Backup 
To synthesize a new property modified archive based on the existed backup images of the selected 
disk/partition with the Synthetic Backup Wizard, simply do the following: 

1. On the Common Tasks bar click the Synthetic Backup item of the Wizards menu. 
 
2. On the Synthetic Backup Wizard's Welcome page, click the Next button. 
 
3. On the Browse for Archive page, select the required archive in the browser-like window. 
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The Archive File Details section displays a short description of the selected image. Click the 
Next button. 
 
4. The Archive Contents page displays detailed information about the contents of the 
archive. It includes a full description of properties about the archived disks or partitions. 
Click the Next button. 
 
5. On the Synthesis Settings page the user can define: 

 Whether the archive integrity will be controlled. 
 

 

Checking archive integrity enables to guarantee that all backup images created with the 
program are 100 percent flawless. Nevertheless if you decided not to control the archive 
integrity, the backup operation would take about 3-5% less time. 

 
 Compression level for the backup image (including the No compression variant) 
 Whether the archive will be split (if this is the case the user can set the maximum size for the 

archive files). 
 Whether the archive will be protected by password. 
 Recording speed when the user wants to burn the backup image onto CD/DVDs. 

Click the Next button. 

5. On the Synthetic Archive Destination page, select the necessary operation: 

 Save data to local/network drives 
 Save data to physical partitions 
 Burn the data to CD/DVD 

Click the Next button. 

6. Add comments to the backup describing its contents.  

Click the Next button. 

After the operation is completed the user receives a new synthesized backup of the selected disk/partition. It 
is placed into the specified destination (a local or network disk, or a CD/DVD disc), its features defined by 
the wizard. 
  

 
This function is currently unavailable for modification of entire hard disk backups. 

7.6 Storing Backup Images onto External Media  
To store backup images on CD/DVD with the Backup Wizard, simply do the following: 

1. Click the Back Up button in the Tool bar (any of the ways described earlier can also be 
used here to call the Backup Wizard). 
 
2. On the Backup Wizard's Welcome page, click the Next button. 
 
3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or 
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a partition’s name depending on the chosen task. Click the Next button. 
 
4. On the Backup Destination page, select the Burn the data on CD / DVD option. Click the 
Next button. 
 
5. Select a recordable device on the list and edit the archive name, if necessary. Click the 
Next button. 
 
6. Add comments to the backup describing its contents. 
 
7. Select how to perform the operation: 

 immediately (the Back up now option) 
 or generate a script in accordance with the entered settings  

Click the Next button. 

7.7 Storing Backup Images on a Network Drive  
To save a backup archive on a network drive with the Backup Wizard, simply do the following: 

1. Click the Back Up button in the Toolbar (any of the ways described earlier can also be 
used here to call the Backup Wizard). 
 
2. On the Backup Wizard's Welcome page, click the Next button. 
 
3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or 
a partition’s name depending on the chosen task. Click the Next button. 
 
4. On the Backup Destination page, select the Save data to local/network drives option. 
Click the Next button. 
 
5. Select a network disk (it must be mounted and be available in the system by a drive 
letter). Please take into account values of the parameters Estimated archive size and Space 
available on backup destination - if the archive size exceeds the available space, another 
network drive needs to be selected. 
 
6. Edit the archive name if necessary and click the Next button. 
 
7. Add comments to your backup describing its contents. 
 
8. Select how to perform the operation: 

 immediately (the Back up now option)  
 or generate a script in accordance with the entered settings  

Click the Next button. 

7.8 Using the Backup Capsule  
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When the user starts the program, it checks whether the Backup Capsule exists in the system or not. If it has 
not been found, the user is offered to create a Capsule automatically. All operations related to the Backup 
Capsule, including its creating and managing, are performed with the Manage Backup Capsule Wizard.  

7.8.1 Starting  

There are several ways to start the Manage Backup Capsule Wizard: 
  

 In the Main menu: select Wizards > Manage Backup Capsule 
 On the Common Tasks bar: click the Manage Backup Capsule item of the Wizards menu. 
 Select a bar corresponding to the hard disk on the Disk map and click the Create a Backup Capsule 

item on the page that appeared in the Explorer bar. 
  

After any of the mentioned actions the Welcome page of the wizard will be displayed. 
 

 

7.8.2 Settings  

The Manage Backup Capsule Wizard allows the user to configure the settings and then start the operation in 
accordance with the entered parameters. In our case we set the following parameters of the backup capsule: 

 The place where the backup capsule will be created. The user should select a hard disk (if 
the computer has several hard disks) and then select position for the future backup capsule on 
the disk. 
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The backup capsule can be created as a primary partition or as a logical drive within an 
extended partition. It can be inserted into any place on the hard disk: at the end (preferable), 
at the beginning or somewhere in the middle between other partitions. 

 

By default, the program allows the user to create the backup capsule only as the last primary 
or as the last logical drive within the extended partition. However, by activating the advance 
mode on the first page of the wizard you can remove this restriction that in its turn might 
result in some boot problems. 

 The size of the backup capsule. It will be created at the expense of free space of the selected 
disk. 

 

There is no restriction on the size of the backup capsule, merely depending on the available 
space of the hard disk and the capacity needed for the backup. 
 
If the wizard cannot find enough free space in one block, it will redistribute free space, 
joining all free space blocks together into one united block and moving partitions when 
necessary. If the total amount of free space is still not enough, it is possible to split a fragment 
of space from one of the existing partitions, thus resizing it. 

 

If the partition is locked and cannot be resized, the wizard makes the system reboot to create 
the backup capsule and automatically boots the system again. (The rebooting mechanism is 
different for different versions of Windows) 

 Possibility to boot the system from the backup capsule. 
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The program enables the user to start up the computer from the image contained in the backup 
capsule. This may be of great use in case of the operating system corruption. There are the following 
additional parameters for this operation: 

- Time period in seconds the startup message will be displayed; 
- A hot key used to choose the backup capsule as the bootable device. 

 
Besides the user can preview the startup message in the box below the settings. 

  

 

It is recommended to create the bootable backup capsule, as it will help in case of the 
operating system corruption. 
 
This operation will result in overwriting of the current MBR, thus in case of having a third 
side boot manager, it will be removed. To avoid that the user can save the current MBR with 
the help of the Edit/View Sectors tool. 
  
The backup capsule can only be bootable if it is located on the bootable device (assigned in 
the BIOS). 

7.8.3 Results  

Depending on the user’s choice the Manage Backup Capsule Wizard: 
  

 Starts the operation 
 Allows the user to return and correct the parameters mentioned above. 

  
After the wizard has completed, the user will have created a secured place, i.e. the backup capsule, in which 
new backup archives can be stored. 

7.8.4 Managing the Backup Capsule  

All operations of the Backup Capsule management are performed with the Manage Backup Capsule Wizard 
mentioned above. The user can: 
  

 Change the backup capsule size, if necessary 
 Store multiple backup images 
 View and control stored images 

7.9 Backup Capsule on a Disk with only one Partition  
Suppose that the user has only one hard disk with only one partition (the only partition is always system). 
Suppose that there is enough free space on the hard disk to create the backup capsule as well. It can be 
created with the Manage Backup Capsule Wizard: 

1. On the Common Tasks bar, click the Manage Backup Capsule button. 
 
2. On the Backup Wizard's Welcome page, click the Next button. 
 
3. Select a place on the disk where the backup capsule will be created (see the illustration 
below). Click the Next button. 
 
4. Set the size for the backup capsule. Click the Next button 
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5. Start the operation (by clicking the Next button) or return to correct the settings. 

 
After this, the user can place the backup archives into the created backup capsule. For example, one could 
take a full snapshot (with compression) of the system partition at monthly intervals and perform incremental 
backup on a daily basis.  

7.10 Restoring a Disk from the Image  
The restoring process is the reverse of the backup operation, and is performed less frequently. To meet the 
requirements of any user this operation can be accomplished either with the Restore Wizard or through the 
corresponding dialog.  

7.10.1 Starting Wizard  

There are several ways to start the Restore Wizard: 
  

 In the Main menu: select Wizards > Restore Disk or Partition… 
 On the Common Tasks bar: click the Restore hard disks or partitions item of the Wizards menu. 
 Select a bar corresponded to a hard disk (or a partition) on the Disk map and click the Restore the 

entire disk from an image item (or the Restore an image of the logical disk from an image item in the 
partition case) on the page that appeared in the Explorer bar. 
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After any of the mentioned actions the Welcome page of the wizard will be displayed. 
 

 

7.10.2 Starting Dialog 

In order to start the operation the user should take the following steps: 
 
1. Select a hard disk/partition on the Disk Map or on the List of Partitions. 
 
2. Call the Restore Hard Disk/Partition dialog to define appropriate settings: 

 
 In the Main menu: select Hard Disk/Partition > Restore Hard Disk or Partition… 
 Call the popup menu for the selected hard disk/partition (right click of the mouse button) on the Disk 

Map, then select the menu item: Restore Hard Disk or Partition… 

7.10.3 Settings  

Despite different work algorithms, both the Restore Wizard and the Restore Hard Disk/Partition dialog 
provide the same level of functionality, thus let us just take as an example the wizard version of the 
operation. In our case we set the following parameters of the restore operation: 
  

 A backup image to be restored. The Browse for archive page enables to browse disks for an 
appropriate backup image.  
 
By clicking the Switch to File View link, the user can find the required image in the browser-like 
window. The section below (i.e. Archive File Details) displays a short description of the selected 
image. 
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Moreover, on this page the user has the possibility to create new folders or delete existing 
files/folders by clicking the appropriate buttons. 
 
By clicking the Switch to Archive List View link, the user can see the list of all images created with 
the Backup Wizard. To get a clear-cut picture on properties of the required image, just click on it and 
the section below (i.e. Archive File Details) will display a short description. 
 

 
 
Besides, the user may differentiate images of partitions or hard disks by setting up the filter in the 
left top corner of the page. 

 

 

To restore a differential backup it is required to have at disposal both the necessary 
differential backup archive and its base image. Only the differential backup archive is to be 
selected. The Wizard then will automatically attempt to find the corresponding base image 
and start the operation. 
  
In case the base image was burned to a CD/DVD or its location changed since the time of 
creation, the program would ask the user to provide the exact path to it. 

 
 An item of the selected archive to be restored. The program allows the user to restore not only an 

entire archive, but also separate items of the archive. It is very convenient in case of restoring 
separate partitions from the entire disk archive. 
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 A place to restore the archive to. Selecting the destination, please note - all contents on the disk 
selected for restoring purposes will be deleted during the operation. 
 

 
 
To help the user get a clear-cut picture of the operation outcome, the program allows inspecting the 
resulted disk layout. 
 

 

7.10.3.1 Restoring Partition:  

 Size of the restored volume and free space before and after it on the disk. 
 

 
 

 Drive letter assignment after restore. The pull-down list contains vacant drive letters that can be 
associated with the restored partition. 
 

 

7.10.3.2 Restoring Hard Disk: 
 Copy data and resize partitions proportionally. If this option is activated, the program 

proportionally changes the size of partitions keeping their relative order intact. The option can be 
useful when restoring to a larger hard disk. 
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 Perform surface test. Define whether the surface test will be accomplished during the operation or 
not. 
 

 

7.10.4 Results  

Depending on the user’s choice the Restore Wizard: 
  

 Starts the restore operation, 
 Allows the user to return and correct the parameters mentioned above. 

The wizard will restore a disk (or partition) that has been archived, and make it available to use in the 
operating system.  

 

The user has the ability to restore original dynamic volumes as dynamic volumes of any type, 
providing the targeted dynamic disk is of the appropriate size. Moreover the program 
enables to restore dynamic volumes as basic partitions and vice versa. 

7.11 Using the Simple Restore Wizard  
It can happen that the user cannot initiate the restoring process under Windows because the operating system 
is damaged in some way. In this case the Simple Restore Wizard is to be used.  

7.11.1 Starting  

In order to start the Simple Restore Wizard the user needs to boot from Recovery Media and then launch the 
wizard. Moreover, if the user should create bootable archives, the Simple Restore Wizard will run 
automatically when the user boots from the first CD/DVD of a backup archive. 
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7.11.2 Settings  

The Simple Restore Wizard allows the user to set the parameters of the restore operation: 
  

 The backup image that contains the system partition to restore. The user can browse disks for 
appropriate backup images. The wizard provides in-depth information on the selected archive. 

  

 

To restore a differential backup it is required to have at disposal both the necessary 
differential backup archive and its base image. Only the differential backup archive is to be 
selected. The Wizard then will automatically attempt to find the corresponding base image 
and start the operation. 
  
In case the base image was burned to a CD/DVD or its location changed since the time of 
creation, the program would ask the user to provide the exact path to it. 

  
 A place to restore the archive to. All contents on the disk selected for restoring purposes will be 

deleted during the operation. The program enables the user to inspect the resulted disk layout. 
 Size of the restored volume (if necessary). The program allows the user to inspect the resulted disk 

layout. 
 Size of the free spaces before and after the restored partition on a disk.  

7.11.3 Results  

After the wizard has completed, the system partition which was stored in the backup image, will be restored 
and the operating system available to use.  

7.12 Restoring the System Disk  
The user can restore the operating system with a previously made recovery CD/DVD. It is assumed that the 
recovery CD/DVD was made with the Recovery Media Wizard (see the contents of the recovery media 
settings). The following steps are useful:  
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1. Insert the Recovery CD/DVD into a bootable CD/DVD device (the BIOS must be 
enabled to boot the system from the CD/DVD device). 
 
2. Restart the computer. 
 
3. The Simple Restore Wizard will be started automatically. Click the Next button on the 
Welcome page. 
 
4. On the What to restore page, either type the full path to the backup image of the system 
disk, which you are going to restore, or click the standard browse button [...] to find it. 
Click the Next button 

 

To restore a differential backup it is required to have at disposal both the necessary 
differential backup archive and its base image. Only the differential backup archive is to be 
selected. The Wizard then will automatically attempt to find the corresponding base image 
and start the operation. 
  
In case the base image was burned to a CD/DVD or its location changed since the time of 
creation, the program would ask the user to provide the exact path to it. 

5. On the Image properties page, make sure that you select the correct image viewing the 
provided information about the archive. When the archive has been chosen, click the Next 
button.  
 
6. On the disk layout map, select a system disk, to be restored. Click the Next button. 
 
7. Set the size of the system partition. The user can compress or expand it at the expense of 
available unused space. Click the Next button. 
 
8. Click the Finish button to initiate the restoring process. 
 
9. After completing the operation eject the Recovery CD/DVD and reboot the computer. 

Now the restored file system is operable once again.  

7.13 Restoring Separate Files and Folders from an Image  
To restore separate files and folders from backup images with the Volume Explorer follow the steps below: 

1. In the Explorer bar, click the Disk View tab and then choose Volume Explorer. 
 
2. Browse for the required archive and then open it by double click of the left mouse button. 
 
3. Select a file (or a folder). 
 
4. Call the popup menu (right click of the mouse button). 
 
5. Select the Export item. 
 
6. Select a place on the disk where the file (or the folder) will be extracted to. 

7.14 Restoring Dynamic Volumes  
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The user has the ability to restore original dynamic volumes as dynamic volumes of any type, providing the 
targeted dynamic volume is of the appropriate size. Moreover the program enables to restore dynamic 
volumes as basic partitions and vice versa. 
 
To restore a dynamic disk as is with the Restore Wizard, simply do the following: 

1. Click the Restore button in the Tool bar (any of the ways described earlier can also be 
used here to call the Restore Wizard). 
 
2. On the Restore Wizard's Welcome page, click the Next button. 
 
3. On the Browse for Archive page, select the required archive in the browser-like window. 
The Archive File Details section displays a short description of the selected image. Click the 
Next button. 

 

To restore a differential backup it is required to have at disposal both the necessary 
differential backup archive and its base image. Only the differential backup archive is to be 
selected. The Wizard then will automatically attempt to find the corresponding base image 
and start the operation. 
  
In case the base image was burned to a CD/DVD or its location changed since the time of 
creation, the program would ask the user to provide the exact path to it. 

4. The What to Restore page displays detailed information about the contents of the archive. 
It includes a full description of properties about the archived disks or partitions. In case you 
have a complex archive, select the required item to restore.  
 

 
 
Click the Next button. 
 
5. On the Where to Restore page, select a place to restore the archive to similar in size to the 
original dynamic volume. There is no need to mark all the constituents of the dynamic 
volume, the program will do it automatically. 
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Click the Next button. 
 
6. Depending on the user’s choice the Restore Wizard: 

 starts the operation 
 reconsiders it 

The wizard will restore the required dynamic disk and make it available to use in the operating 
system. 

7.15 Build Recovery Media  
In addition to the backup tools described above, the program provides the possibility to prepare a set of 
recovery tools on external media (CD, DVD or floppy disks). The tool set can be of assistance in case of 
operating system corruption, which means that the user is able to boot the computer even when the operating 
system is not able to do so. Creation of such recovery tools is performed with the Recovery Media Wizard.  

7.15.1 Starting  

To start the Recovery Media Wizard the user needs to select the Recovery Media Builder item of the Wizards 
menu on the Common Tasks bar. Then the Welcome page of the wizard is displayed. 
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7.15.2 Settings  

The Recovery Media Wizard allows the user to configure the settings and start the operation in accordance 
with the entered parameters. In our case we set the parameters of the future recovery tool by defining: 
  

 Type of the recovery media the user is creating. The recovery tools can be placed either on a 
CD/DVD disc or on a floppy disk. 

 

 
 

 Contents of the recovery set. The recovery tools can include the standard Recovery Media image 
(included in the installation package) or software defined by the user. In the last case the user can 
record a prepared image by setting the path to the image file on the disk. 
 

 
 

 A recording device. The appropriate external media (CD/DVD or a floppy disk) needs to be inserted 
into the selected device. 

 CD/DVD writing parameters (in case the user selects this kind of media). Writing parameters 
include writing speed (maximum or minimum) and the ability of ejecting the recorded disc after 
completing the operation. 
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The program supports CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW and also DVD-R, DVD+R 
double layer discs. If the inserted disc is not empty, the Wizard suggests the user erasing its contents. When 
the user confirms the operation, the program deletes the re-writable disc's contents and begins the recording 
process.   

7.15.3 Results  

The Recovery Media Wizard starts the operation after completing the settings mentioned above. As a result, 
the user receives recovery media, which can be used in most emergencies. 
 
When purchasing the program online, Recovery Media is available as ISO-image files. The Recovery Media 
Builder can then write these files onto physical CD/DVDs.  
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8 Copy Tasks  
This chapter lists various scenarios of copy operations which may be accomplished by the program. This has 
already been reviewed in the Basic concepts chapter. Here the user will find more useful recommendations 
and descriptions of operations. 

8.1 Copy Hard Disk 
In the Basic concepts chapter we mentioned about possible applications of this operation. The program 
provides the ability to clone hard disks of any file system. During the hard disk copying process, the 
program moves controlling records of used partitioning scheme, the bootstrap code and on-disk partitions. 
This operation cannot be substituted by simply copying all on-disk partitions.  
 
The operation can be accomplished with the Copy Hard Disk Wizard. The wizard is so well designed that 
the user simply needs to follow its easy instructions to make an exact copy of the disk.  

8.1.1 Starting  

There are several ways to start the Copy Hard Disk Wizard: 
  

 In the Main menu: select Wizards > Copy Hard Disk… 
 On the Common Tasks bar: click the Copy Hard Disk item of the Wizards menu. 
 In the Toolbar: click the Copy Hard Disk button. 
 Select a disk on the Disk map and click the Copy Hard Disk item on the page that appears in the 

Explorer bar. 
  

After following one of the above mentioned actions, the Welcome page of the wizard is displayed.  
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8.1.2 Settings 

The Copy Hard Disk Wizard allows the user to configure the settings and then start the operation in 
accordance with the entered parameters. Here the user sets the parameters of the operation defining: 

 The hard disk to copy. Select a hard disk you want to copy 
 Copy parameters. The Copy Hard Disk Wizard allows the user to specify the following 

options:  
 

 

- Copy options. This section enables to switch between two options:  
HDD raw copy (allows to copy a hard disk in the sector-by-sector mode to successfully process 
unknown file systems). 
Partition raw copy (allows to copy a partition in the sector-by-sector mode to successfully process 
unknown file systems). 
Perform incremental copy (once the complete copy of a hard disk is created, it can be used as a base 
for the incremental copy. Mark the option to make the program perform the exact bit-wise 
comparison of the previous data (saved in the parental copy) with the current data (that is actually the 
hard disk itself). After that only most recent information will be processed. It considerably decreases 
the amount of data written). 
- Resize options. This section enables to switch between two options: 
Remove free blocks between partitions. If this option is activated, the program does not keep blocks 
of free space between partitions on the targeted hard disk. 
Copy data and resize partitions proportionally. If this option is activated, the program proportionally 
changes the size of partitions keeping their relative order intact. The option can be useful when 
upgrading the hard disk to a larger one. 
- Verification options. This section allows the user to define whether the Surface test and/or the 
Writing Verification test will be accomplished during the operation. 

8.1.3 Results 

Depending on the user’s choice the Copy Hard Disk Wizard: 
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 starts the operation 
 reconsiders it 

  
After the operation is completed the user receives a fully functional duplicate of the existing hard disk.  

8.2 One Button Copy Wizard 
One of the fundamental features of the program is the ability to clone hard disks by pressing just one button, 
i.e. launching the One Button Copy Wizard. To successfully accomplish the operation your system should 
meet the following requirements: 
  

 at least two hard disks, one of which should contain data and the other is empty 
 the destination hard disk should have enough space to take contents of at least first partition of the 

source disk 

8.2.1 Starting 

There are several ways to start the One Button Copy Wizard: 

 In the Main menu: select Wizards > One Button Copy Wizard 
 On the Common Tasks bar: click the One Button Copy Wizard item of the Wizards menu.  

 

 
 

Actually, that is all. The Wizard displays its main window, where you can see source and destination disks 
and three available options: 
  

 Copy all sectors one to one (to process corrupted and unknown file systems - more time required) 
 Perform incremental copy (once the complete copy of a hard disk is created, it can be used as a 

base for the incremental copy. Mark the option to make the program perform the exact bit-wise 
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comparison of the previous data (saved in the parental copy) with the current data (that is actually the 
hard disk itself). After that only most recent information will be processed. It considerably decreases 
the amount of data written) 

 Copy without free space blocks (to arrange partitions one after another)  
 Resize proportionally (to proportionally change the size of partitions keeping their relative order 

intact) 

8.2.2 Results 

The operation will be automatically accomplished after a ten-second pause. In case you are willing to 
modify some of the default options, press the Pause button, to continue execution press Start. To interrupt 
the operation, press the Cancel button.  
 
By default the Progress dialog will be closed after the operation is successfully completed. In case there are 
some problems, the user can see it and find out what has happened.  

8.3 Copy Partition 
The copying of partitions can be used either for cloning sample partitions or for making backup copies of 
working partitions.  
 
The user can duplicate partitions to protect oneself from downtime in case of a system malfunction. The 
partition can be copied back to the original place within a few minutes or can be used simply for copying 
separate files.  
 
The program duplicates all usable partition data including files, the exact structure of directories and file 
system metadata: location of files, security information, access quotas and so on. The program allows to 
copy partitions only to blocks of free space. 

8.3.1 Starting  

There are several ways to start the Copy Partition Wizard: 
  

 In the Main menu: select Wizards > Copy Partition… 
 On the Common Tasks bar: click the Copy Partition item of the Wizards menu. 
 In the Toolbar: click the Copy Partition button. 
 Select a disk on the Disk map and click the Copy Partition item on the page that appears in the 

Explorer bar. 
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After following one of the above mentioned actions, the Welcome page of the wizard is displayed.  
 

 

8.3.2 Settings  

The Copy Partition Wizard allows the user to configure the settings and then start the operation in 
accordance with the entered parameters. Here the user sets the parameters of the operation defining: 
  

 The partition to copy. Select a partition you want to copy 
 Destination disk. Select a hard disk with free space enough for performing the copy partition 

operation 
 Copy parameters. The Copy Partition Wizard allows the user to specify the following options: 

  
- Copy the partition with resize. This option gives the possibility to copy the partition to a block of 
free space, which is smaller than the partition itself.  
- Partition size. Define the size (in Mb) of the copied partition.  
- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of 
the available range of disk space.  
- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range 
of disk space.  
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8.3.3 Results 

Depending on the user’s choice the Copy Partition Wizard: 
  

 starts the operation 
 reconsiders it 

  
After the operation is completed the user receives a fully functional duplicate of the existing partition.  
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9 Scripting 
The program actions can also be represented in form of a script. The script describes the appropriate 
operation with macro-language commands. There is an interpreter utility - SCRIPTS.exe, which is included 
in the program installation package. This utility works in the unattended mode, which allows the user to 
automate operations. 

9.1.1 Starting 

The user may not write a script since the program has a convenient interface for such a task. In order to 
generate a script on the base of the entered parameters of the required operation, the user should take the 
following steps: 
  

 Select in the Main menu: Tools > Generate Script…  
  

 
This command is unavailable if there are no operations on the List of Pending Operations. 

9.1.2 Settings 

Define script generation options with the Generate script dialog. 
 

 
  

 Script file destination. The program allows saving script files to local drives. Press the Browse 
button to define destination and a filename for a new script file. The default file extension that is 
reserved for scripting files is .psl. However, a script can be saved under any filename. 
  

In addition, there is the possibility to make further detailed settings (although the default values will do in 
most cases). To activate the advance mode, the user needs to click the More options button at the foot of the 
dialog page. The following options become available: 
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 Interaction with the user. Mark the option to pause the script interpreter during the execution to 

prompt the user’s confirmation or other input. Otherwise the program will not stop using default 
values for parameters if needed. 

 Commit after each operation. Mark the option to commit changes after each operation. 
 Check for errors after each operation. Mark the option to insert a special code in script, which 

checks the status of the last executed operation and stops the script processing if there are errors of 
any kind. 

9.1.3 Results  

After the operation is completed the user receives a new script file. It is placed into the specified destination, 
its features defined in the dialog. 
  

 
To learn more about scripts please consult the Paragon Scripting Language manual. 
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10 Partition Management 
In this chapter you will find all the information necessary to carry out partitioning operations supported by 
the program. 

10.1 Basic Partitioning Operations 
In this chapter you will find all the information necessary to carry out basic partitioning operations (create, 
format, delete) supported by the program. To meet the requirements of any user these operations can be 
accomplished either with the help of easy-to-use wizards or through the corresponding dialogs. 

10.1.1 Create Partition 

The program provides the ability to create new partitions by using the DOS partitioning scheme.  

10.1.1.1 Restrictions  
1. Do not use the Create Partition function in order to undelete the last deleted partition. 
2. The program cannot create new partitions on Dynamic Disks. The current version of the program supports 
only hard disks that use the DOS partitioning scheme (in Windows 2000 and XP these disks are named 
Basic Disks). 
3. According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be 
created: 

 Two Extended Partitions on one hard disk 
 Five or more Primary partitions on one hard disk 
 If there is an Extended Partition on the disk, only three Primary partitions are allowed 

4. The program allows creating new partitions only within blocks of unpartitioned space. It cannot convert a 
free space on an existing partition to a new partition. 

10.1.1.2 Starting 
In order to start the operation the user should take the following steps:  
 
1. Select a block of free space on the Disk Map.  
 
2. Call the Create Partition dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Partition > Create Partition. 
 Call the popup menu for the selected partition (right click of the mouse button) then select the menu 

item: Create Partition. 

10.1.1.3 Settings 
Define the future partition parameters with the Create Partition dialog. Initially the program suggests some 
consistent values for all parameters. In most cases, the user can just press the Yes button to confirm the 
operation.  
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 Define whether the partition will be Primary or Extended one. Select the desired type of the new 
partition in this pull-down list. As a matter of fact, the available alternatives fundamentally depend 
on the type of the selected block of free space - within the Logical free space, only Logical partitions 
can be created; Within the Primary free space, both Primary partitions or the Extended Partition can 
be created. 

 Partition Size. This slider defines the size (in MB) of the new partition. 
 Free space before. This slider defines the position (in MB) of the new partition relative to the 

beginning of the block of free space. 
 Free space after. This slider defines the amount of trailing free space (in Mb) at the end of the new 

partition. 
 File system for new partition. Mark the option in order to immediately format the newly created 

partition. Otherwise, the partition will remain unformatted (so that it will not be ready to use).  
  
In addition, there is the possibility to make further detailed settings (although the default values will do in 
most cases). To activate the advance mode, the user needs to click the More options button at the foot of the 
dialog page. Depending on the file system, the following options become available: 
 

 
  

 Use OS built-in routine. Mark the option to restrict the available values according to the used OS. 
 Whether the surface test will be performed. Mark the option to make the program perform the 

surface test on the formatted partition. In this case, the program will find bad and unstable sectors 
and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file 
systems. Set the number of sectors to be reserved for the boot area on the partition with this spinner 
control. 
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 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the 
maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this 
spinner control. 

10.1.1.4 Results  
After the operation is completed the user receives a fully functional partition. 

10.1.2 Format Partition 

Any partition should contain some file system to be used for keeping data. The process of installing a file 
system is commonly known as formatting. A huge variety of file systems have been developed these days. 
The program can format partitions of the following file systems: 
  
   - FAT12 & FAT16 
   - FAT32 
   - NTFS 
   - Ext2 
   - Ext3 
   - ReiserFS 
   - Linux Swap v. 2 
   - HPFS 

10.1.2.1 Starting 
In order to start the format partition operation the user should take the following steps:  
 
1. Select a partition on the Disk Map. The operation is disabled for the Extended Partition and for blocks of 
free space.  
 
2. Call the Format Partition dialog to define appropriate settings. There are the following ways to do it: 
  

 Select in the Main menu: Partition > Format Partition.  
 On the Explorer bar: click on the current file system.  
 Call the popup menu for the selected partition (right click of the mouse button) then select the menu 

item: Format Partition. 

10.1.2.2 Settings 
Define parameters of the formatting operation with the Format Partition dialog. Initially the program 
suggests some consistent values for all parameters. In most cases, the user can just press the Format button 
to confirm the operation.  
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 File system. Select the desired file system type from this pull-down list. In fact, the program displays 
only file systems that can be correctly placed to the selected partition, taking the capacity of the 
selected partition into account.  

 Volume label. Enter a label for the selected partition in this textual field. The Volume label is an 
unimportant parameter of a logical drive that can be used for drive identification. 

  
In addition, there is the possibility to make further detailed settings (although the default values will do in 
most cases). To activate the advance mode, the user needs to click the More options button at the foot of the 
dialog page. Depending on the file system, the following options become available: 
 

 
  

 Use OS built-in routine. Mark the option to restrict the available values according to the used OS. 
 Whether the surface test will be performed. Mark the option to make the program perform the 

surface test on the formatted partition. In this case, the program will find bad and unstable sectors 
and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file 
systems. Set the number of sectors to be reserved for the boot area on the partition with this spinner 
control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the 
maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this 
spinner control. 

10.1.2.3 Results  
After the operation is completed the user receives a fully functional partition formatted to the file system 
specified.  

10.1.3 Delete Partition 

The program allows the user to delete partitions on hard disks partitioned with the DOS partitioning scheme. 
The program removes references to the partition from the Partition Table, so that the information from the 
deleted partition becomes inaccessible. The resulted disk space can be used to create new partitions.  
 
Contents of the deleted partition do not disappear from the disk but merely are unavailable for the operating 
system. 

10.1.3.1 Starting 

In order to delete a partition the user should take the following steps:  
 
1. Select a partition on the Disk Map.  
 
2. Call the Delete Partition dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Partition > Delete Partition.  
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 Call the popup menu for the selected partition (right click of the mouse button) then select the menu 
item: Delete Partition. 

10.1.3.2 Settings 
Define parameters of the delete operation with the Delete Partition dialog. Initially the program suggests 
some consistent values for all parameters. In most cases, the user may just press the Yes button to confirm 
the operation.  
 

 
  

 Enter the volume label to confirm deleting. To confirm the deletion of the selected partition, enter 
its Volume Label. The actual Volume Label value is displayed above. 

 Do not ask volume label next time. This checkbox allows the user to inhibit confirmation of the 
partition deletion. 

10.1.3.3 Results 
The deletion of a partition takes only a fraction of a second. However, the program waits until Windows 
completes the modification of the disk layout.  

10.2 Advanced Partitioning Operations 
In this chapter you will find all the information necessary to carry out advanced partitioning operations 
supported by the program. 

10.2.1 Undelete Partition 

When deleting a partition, disk management software only removes references to it in the Partition Table so 
that a previously deleted partition can still be recovered (in case of valid restoration of the record in the 
Partition Table). The program provides the ability to find and recover these partitions. This function 
minimizes the hazard of occasional partitions deletion and is usually known as undelete.  
 
A restored partition will be fully functional, as long as other partitions were not created, moved or exceeded 
the disk space occupied by the partition. That is why the program enables the Undelete Partition function 
only for blocks of free space.  
 
The operation can be accomplished with the Undelete Partition Wizard. 

10.2.1.1 Starting 
There are several ways to start the Undelete Partition Wizard: 

 In the Main menu: select Wizards > Undelete Partitions… 
 Select a disk on the Disk map and click the Recover Lost Partitions item on the page that 

appears in the Explorer bar. 
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After following one of the above mentioned actions, the Welcome page of the wizard is displayed.  
 

 

10.2.1.2 Settings 
The Undelete Partition Wizard allows the user to configure the settings and then start the operation in 
accordance with the entered parameters. Here the user sets the parameters of the operation defining: 
  

 Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available disks 
and their partitions. 

 

 
 

 Manual setting of search criteria. Activate the advance mode 

 to manually specify: 
- A particular file system to look for; 
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- Required search criteria. 
 

 
 

 
To use the advance mode, a good knowledge of hard disk structure is required. 

10.2.1.3 Results 
Depending on the user’s choice the Undelete Partition Wizard: 

 starts the operation 
 reconsiders it 

After the operation is completed the user receives a fully functional partition.  

10.3 Changing Partition Attributes 
This chapter explains how the user can change partition attributes (Active flag, Hidden flag, Partition ID, 
Volume Label). 

10.3.1.1 Mark Partition Active/Inactive 
The program enables to set Active/Inactive flag for primary partitions of the hard disk. By default the 
operating system will boot from the active (bootable) partition at startup. 
  
In order to mark partition Active/Inactive the user should take the following steps: 
  
1. Select a primary partition on the Disk Map. 
  
2. There are several ways to Mark Partition Active/Inactive: 
  

 Select in the Main menu: Partition > Mark Partition Active/Inactive. 
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 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 
then select the menu item: Mark Partition Active/Inactive. 

  

 
  

 
There can only be one active partition on a hard disk, otherwise the operating system will fail 
to boot. 

  
3. The operation will be performed immediately after confirmation. 

10.3.2 Hide/Unhide Partition 

The program allows the user to Hide/Unhide primary and logical partitions. The operating system does not 
mount hidden partitions, thus preventing access to their contents. 
  
In order to Hide/Unhide a partition the user should take the following steps: 
  
1. Select a partition on the Disk Map.  
2. There are several ways to Hide/Unhide partitions: 
  

 Select in the Main menu: Partition > Hide/Unhide Partition. 
 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 

then select the menu item: Hide/Unhide Partition. 
  

 
It is strongly recommended not to hide the system partition, otherwise the operating system 
will fail to boot. 

  
3. The operation will be performed immediately after confirmation. 

10.3.3 Set Label of a Partition 

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. 
This value is detectable by any partitioning tool; it is used for notification purposes only. 
  
In order to change a partition label the user should take the following steps: 
  
1. Select a partition on the Disk Map.  
  
2. Call the Change Volume Label dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Partition > Modify > Change Volume Label. 
 On the Explorer bar: click on the current volume label. 
 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 

then select the menu item: Change Volume Label. 
  
3. Define the label of the partition with the Change Volume Label dialog: 
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New volume label. Enter the new value of the Partition Label. The length of the Label is limited to 11 
characters. 
  
The dialog also displays the current partition label.  
  
4. The operation will be performed immediately after confirmation. 

10.3.4 Change Partition ID 

Partition ID is an identifier of a file system that is placed in the partition. Partition ID is saved in the 
Partition Table; it is used to quickly detect partitions of supported types. By manually changing the Partition 
ID value, it is possible to manipulate the accessibility of partitions. 
  
In order to change a Partition ID the user should take the following steps: 
  
1. Select a partition on the Disk Map.  
  
2. Call the Change Partition ID dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Partition > Modify > Change Partition ID… 
 On the Explorer bar: click on the current partition ID. 
 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 

then select the menu item: Change Partition ID… 
  
3. Define the ID of the partition with the Change Partition ID dialog: 
  

 
  

 Predefined ID. Select from the pull-down list ID values for various file systems. 
 Enter ID manually. The textual field contains a hexadecimal presentation of the Partition ID. 

Generally, the Partition ID should be presented as 1-2 digits hexadecimal number; only hexadecimal 
digits {0..9, A..F} are allowed to be used. 
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4. The operation will be performed immediately after confirmation. 

10.3.5 Change Serial Number of a Partition 

FAT16, FAT32, HPFS and NTFS file systems include the Serial Number parameter. The partition's Serial 
Number is saved in the boot sector; its value is generated while formatting a partition. 
  
The program enables to modify the partition's Serial Number on formatted FAT16, FAT32, HPFS and NTFS 
partitions without re-formatting. 
  
In order to start the operation the user should take the following steps: 
  
1. Select a partition on the Disk Map.  
  
2. Call the Change Partition Serial Number dialog to define appropriate settings. There are several ways to 
do it: 
  

 Select in the Main menu: Partition > Modify > Change Serial Number. 
 On the Explorer bar: click on the current serial number. 

  
3. Define the parameter value with the Change Partition Serial Number dialog. 
  

 
  
New serial number. The user can enter the new Serial Number value in this textual field. The Serial 
Number should contain 8 hexadecimal figures (0..9 or A..F). The operation cannot be accomplished until the 
user enters all 8 symbols. 
  
4. The operation will be performed immediately after confirmation. 
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11 Hard Disk Management 
This chapter lists various scenarios of hard disk operations which may be accomplished by the program. 

11.1 Update MBR 
The program allows the user to overwrite the current bootable code in the MBR (Master Boot Record) by 
the standard bootstrap code.  
  
This feature can repair corrupted bootable code on a hard disk as a result of boot virus attacks or 
malfunction in the boot managing software. 
  
In order to start the operation the user should take the following steps: 
  
1. Select a hard disk on the Disk Map.  
  
2. There are several ways to run the operation: 
  

 Select in the Main menu: Hard Disk > Update MBR. 
 Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, 

then select the menu item: Update MBR. 
  

 
  
3. The operation will be performed immediately after confirmation. 

11.2 Convert to Basic 
The program provides a unique possibility to convert a dynamic disk containing simple volume(s) into basic 
keeping its contents intact. 
  
In order to start the operation the user should take the following steps: 
  
1. Select a dynamic disk containing simple volume(s) on the Disk Map.  
  
2. Call the Convert to Basic dialog selecting in the Main menu: Hard Disk > Convert to Basic… 
  
3. Define parameters of the operation with the Convert to Basic dialog. 
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Number of primary partitions. According to the DOS partitioning scheme a hard disk can only have no 
more than four Primary partitions. If there is an Extended partition on the disk, only three primary partitions 
are allowed. That is why if a dynamic disk contains several simple volumes the program allows the user to 
choose the number of primary partitions. The rest of them if any will automatically be converted to logical 
disks within the Extended partition.  
  

 
The program can only process dynamic disks containing solid simple volumes (without 
extension). 

11.3 Change Primary Slot 
Operating systems use the following partitions enumeration: 
  
In Linux: 
In Linux, every partition has a special symbolic name that encodes a hard disk containing a partition, and a 
partition itself. Partitions are addressed and accessed by using their symbolic names. Symbolic names are 
automatically generated by Linux in accordance with the order of hard disks in BIOS and the order of 
partition records in the Partition Table. The modification of primary partitions enumeration can lead to the 
changing of paths to some important resources. 
  
In DOS: 
The last versions of MS-DOS use a rather sophisticated algorithm for drive letters assignment. A drive letter, 
which is assigned to a partition, depends on the order of records in the Partition Table. The modification of 
primary partitions enumeration affects the drive letters assignment. In early versions of  
MS-DOS, it can even lead to the unavailability of a partition. In any case, the user may want to change the 
enumeration of primary partitions.  
  
The program provides the ability to change the enumeration of primary partitions. This feature allows the 
user to fix problems concerning the inappropriate order of partitions. 
  
In order to modify the enumeration of partitions the user should take the following steps: 
  
1. Select a hard disk on the Disk Map.  
  
2. Call the Change Primary Slot dialog to define appropriate settings. There are several ways to do it: 
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 Select in the Main menu: Hard Disk > Change Primary Slot. 
 Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, 

then select the menu item: Change Primary Slot. 
  

 
  
3. The dialog displays the actual enumeration of Primary Partitions in the Partition Table (it exhibits the 
order of appropriate records, which refer to primary partitions in the primary part of the Partition Table 
referencing records. The top part of the dialog displays the enumeration order of partitions with the 
parameters that can help to distinguish partitions: 
   - Slot 
   - Volume 
   - Partition type 
   - File system 
   - Partition size  
   - Volume label 
  
There are two buttons on the right of the list of primary partitions, which allow the user to move the selected 
partition up and down within the primary part of the Partition Table. 
  
4. The operation will be performed immediately after confirmation. 

11.4 Change SID 
SID - Security IDentifier, the binary structure that is associated with some object in the system, is used to 
distinguish between user access privileges in workgroup local networks. By default, the SID Changer 
searches Windows installations and then changes SIDs in the found Windows instances to automatically 
generated random SID values.  
 
The program provides the ability to change SIDs:  
 
1. Select a hard disk on the Disk Map.  
 
2. Call the Change SID dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Hard Disk > Change SID. 
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 Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, 
then select the menu item: Change SID. 
  

 
 
3. Generate SID based on BOOT.INI files information. By default, the utility searches for BOOT.INI 
files on all partitions to extract information on Windows installations and then performs modifying of the 
found SIDs by automatically generated random values.  
 
The user can specify some definite directories for search in addition to ones set in BOOT.INI files, or inhibit 
analyzing BOOT.INI files at all. It is also possible to set a SID value manually. 
  

 
The SID changer utility can be applied only to NT and Win2k installations.  
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12 Extra Functionality 
This chapter describes the supplementary functionality available in the program. 

12.1 View Partition/Hard Disk Properties 
The program enables to obtain in-depth information on the properties of hard disks/partitions. Besides the 
general information, such as capacity, used space or file system type it provides the possibility to get info on 
a hard disk geometry, cluster size, exact partition location, etc. 
  
In order to view properties of a partition/hard disk the user should take the following steps: 
  
1. Select a partition/hard disk on the Disk Map. 
  
2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk 
Map, then select the menu item: Properties… 
  

 
  
3. The provided information is grouped according to its properties, thus select the required tab and get the 
information you need. 

12.2 Volume Explorer 
Volume Explorer is a special tool providing the ability to browse and export contents of the local 
mounted/unmounted volumes formatted to FAT16, FAT32, NTFS, Ext2FS, Ext3FS, ReiserFS file systems. 
Besides it allows the user to access Paragon backups as regular folders to explorer their contents or to 
retrieve certain files. 
  
To launch the Volume Explorer the user should click Disk View tab in the Explorer Bar and then choose 
Volume Explorer: 
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Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other 
location (local or network drive, etc.). 
  

 

12.3 File Transfer Wizard 
File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning 
of them to CD/DVD as easy and convenient as possible. It may be of particular use in case of a system 
malfunction, caused either by a virus attack or files corruption, in order to get the system back on track 
again. Besides it provides access to Paragon backups as regular folders to browse through their contents or 
copy required files. 

12.3.1 Starting 

To start the File Transfer Wizard the user needs to select the File Transfer Wizard item of the Wizards menu 
on the Common Tasks bar. Then the Welcome page of the wizard is displayed.  
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12.3.2 Settings 

The File Transfer Wizard allows the user to configure the settings and then start the operation in accordance 
with the entered parameters. Here the user sets the parameters of the operation defining:  
 

 Place to look for files/directories. Select a source disk from the pull-down list in the left pane of the 
page. The program enables to process both mounted and unmounted (without drive letter assigned) 
partitions. Besides it is possible to map a network drive. 

 

 
 

 Object(s) of operation. Choose files/directories you want to copy and place them to Clipboard by 
pressing the Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane 
and press the Remove button. You can also create a new folder, rename or irreversibly delete existing 
files/directories of the left pane by pressing the appropriate buttons. 
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Files/directories deleted from the Clipboard remain intact on source disks. 

 
 Destination to store the object(s). The File Transfer Wizard allows copying data to local or network 

drives, to physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose 
the way the data will be stored. 

 

 
 

 Revision of changes. The Operation Summary page provides structurally divided information on all 
the actions made in the wizard. Check the changes and come back to any of the steps of the wizard to 
correct them (if necessary) by following the required hyperlink. 

 

 
 

12.3.3 Results  

The File Transfer Wizard starts the operation after completing the settings mentioned above. 

12.4 Mount Partition 
The program allows the user to assign or remove drive letters of existing formatted partitions. 

12.4.1 Assign Drive Letter 

In order to mount a partition the user should take the following steps: 
  
1. Select a partition on the Disk Map.  
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2. Call the Add Drive Letter dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Partition > Assign Drive Letter… 
 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 

then select the menu item: Assign Drive Letter… 
  
3. Define a drive letter for the selected partition with the Add Drive Letter dialog. Initially the program 
suggests some consistent value for this parameter. So the user may just press the Yes button to confirm the 
operation. 
  

 
  
Assign the following drive letter. The pull-down list contains vacant drive letters that can be associated 
with the selected partition. Assign a drive letter to a non-mounted partition, or change the existed drive letter 
for already mounted partition. 
  
4. The operation will be performed immediately after confirmation. 

12.4.2 Remove Drive Letter 

In order to unmount a partition the user should take the following steps: 
  
1. Select a partition on the Disk Map.  
  
2. Call the Remove Drive Letter dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Partition > Remove Drive Letter. 
 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 

then select the menu item: Remove Drive Letter. 
  

 
  

 

Modifying drive letter of the system partition will result in inability to boot the operating 
system. 
  
After having processed partitions with installed software, some programs may not run 
properly. 

  
3. The operation will be performed immediately after confirmation. 
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12.5 Mount Archive 
The program provides the possibility to assign a drive letter to a backup image of a separate partition. As a 
result of the operation the user gets a new read-only partition in the system to easily browse its contents and 
copy the required information even with the standard Windows tools. 
  
In order to mount an archive the user should take the following steps: 
  
1. Select a backup image in the Archive database. 
  
2. Call the Mount Archive dialog to define appropriate settings. There are several ways to do it: 
  

 On the Explorer bar: select the Mount Archive item. 
 Call the popup menu for the selected image (right click of the mouse button), then select the menu 

item: Mount the selected archive… 
  
3. Define a drive letter for the selected backup image with the Mount Archive dialog. 
  

 
  
Assign the following drive letter. The pull-down list contains vacant drive letters that can be associated 
with the selected archive. Initially the program suggests some consistent value for this parameter. So the 
user may just press the OK button to confirm the operation. 
  
4. The operation will be performed immediately after confirmation. 
  

 

The current version of the program does not allow the user to mount backup images of an 
entire hard disk, complex archive (containing e.g. MBR and a separate partition, etc.), MBR 
or First Track of a hard disk. However it enables to mount separate partitions from a backup 
image of a hard disk or complex archive. 
  
There is no possibility to mount archives located on physical (unmounted) partitions or in the 
Bootable Capsule. 
  
Archives will only be mounted for the current session and won’t be available after the system 
restart. 
  
It is strongly recommended not to unmount backup images with Windows Disk Manager or 
other third side software. 

12.6 Test Surface 
The program allows performing additional surface tests on existing partitions and blocks of free space.  
  
In order to start the surface test the user should take the following steps: 
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1. Select a partition or a block of free space on the Disk Map.  
  
2. Call the Test Surface dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Partition > Test Surface… 
 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 

then select the menu item: Test Surface… 
  

 
  
Surface test level. Choose the level of the test procedure. 
  
3. The operation will be performed immediately after confirmation. 

12.7 Check File System Integrity 
The program can check the file system integrity on existing partitions. This function can be used for 
detecting file system errors before performing operations on a partition. 
  
Most useful operations require the targeted partition to have a valid file system to be processed. 
  
In order to start the system integrity check the user should take the following steps: 
  
1. Select a partition on the Disk Map.  
  
2. Call the Check File System Integrity dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Partition > Check File System Integrity. 
 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 

then select the menu item: Check File System Integrity. 
  
3. The operation will be performed immediately after confirmation. 

12.8 Check Archive Integrity 
The program provides the ability to perform integrity check for the backup images. The function allows 
distinguishing between valid and corrupted images before using them. The Check Archive Integrity Wizard 
will help you do that. 

12.8.1 Starting 

To start the Check Archive Integrity Wizard the user needs to select the Check Archive Integrity item of the 
Wizards menu on the Common Tasks bar. Then the Welcome page of the wizard is displayed.  
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12.8.2 Settings  

The Check Archive Integrity Wizard allows the user to configure the settings and then start the operation in 
accordance with the entered parameters. Here the user sets the parameters of the operation defining:  
 
An archive to verify. Select an image on your disk in the browser-like window. The Archive File Details 
section displays a short description of the selected image, including: 
  

 information on a type of the archive contents (whether it contains the entire disk or just a partition), 
 whether the archive is compressed or not, 
 whether the archive is password protected or not, 
 the date, when the archive was created. 

12.8.3 Results  

The Check Archive Integrity Wizard starts the operation after completing the settings mentioned above.  

12.9 Check Recovery Disks 
The user has the ability to check whether backup media created with the program is 100 percent error-free 
and ready to use. The Check Recovery Disk Wizard will help you do that. 

12.9.1 Starting 

To start the Check Recovery Disk Wizard the user needs to select the Check Recovery Disks item of the 
Wizards menu on the Common Tasks bar. Then the Welcome page of the wizard is displayed.  
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12.9.2 Settings  

The Check Recovery Disk Wizard allows the user to configure the settings and then start the operation in 
accordance with the entered parameters. Here the user sets the parameters of the operation defining: 
  

 CD/DVD drive to use from the pull-down list 
 Whether eject the disk after the operation is completed or not. 

12.9.3 Results  

The Check Recovery Disk Wizard starts the operation after completing the settings mentioned above.  

12.10 Clear Free Space 
The program allows the user to destroy any remnants of deleted files/directories left on disk without 
affecting the used data by overwriting contents of unused clusters with certain patterns. Besides providing 
high level of data protection this function can be particularly useful when dealing with certain non-standard 
protection/registration/deactivation hidden marks made by some software. 
  
In order to start the operation the user should take the following steps: 
  
1. Select a partition on the Disk Map.  
  
2. Call the Clear Free Space dialog selecting in the Main menu: Partition > Clear Free Space… 
  
3. Define parameters of the operation with the Clear Free Space dialog. Initially the program suggests some 
consistent values for all parameters. In most cases, the user may just press the Wipe button to confirm the 
operation. 
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 HEX value. The Hex value spinner control allows the user to set a two-figure hexadecimal character 
value ("00" by default). The available range is from "00" to "FF". It is synchronized with the ASCII 
value. 

 ASCII value. The ASCII value spinner control enables to set the symbolic presentation of the 
character to use according to the 7-bit American Standard Code for Information Interchange ("#0" by 
default). It is synchronized with the Hex value.  

 Number of passes. The user can choose number of passes for the wiping pattern (1 by default). The 
available range is from 1 to 100.  

 Verify wipe results. The user can also choose whether to carry out residual data verification or not 
specifying the percentage of sectors to check. 

  

 
The Clear Free Space operation is only available for Logical and Primary partitions of 
known file systems. 

12.11 Edit/View Sectors 
With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard 
disks providing the possibility to directly access and modify sectors, save and restore sectors from specified 
files, navigate through the system metadata, etc. 
  
In order to start the Edit/View Sectors operation the user should take the following steps: 
  
1. Select a hard disk/partition on the Disk Map.  
  
2. Call the Edit/View Sectors dialog to define appropriate settings. There are several ways to do it: 
  

 Select in the Main menu: Partition/Hard Disk > Edit/View Sectors. 
 Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk 

Map, then select the menu item: Edit/View Sectors. 
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Careless use of the Edit Sectors function may result in the irreversible data corruption. 

12.12 Send Log Files 
The program allows the user to simplify the procedure of sending support requests to the Paragon Support 
Team. In case of having difficulties with handling the program, the user, with the help of this very function, 
can address the company support engineers and provide them with all the information they need such as disk 
layout, performed operations, etc. in order to tackle the encountered problem. Information of that kind is 
stored in Log files. 
  
In order to start the operation the user should take the following steps:  
 
1. Call the Send Log Files dialog in the Main menu: Tools > Send Log Files 
  
2. Give a detailed description on the encountered problem. 
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By clicking the Send button the built-in mail client will generate a template request with attached 
compressed log files and then send it to the Paragon Support Team. 

12.12.1 Log Files 

Log files are simple textual files that can be opened by any text editor. There are several log files 
automatically generated by the program: 
  

Stubact.log Contains in-depth information on parameters and 
performance of all operations carried out by the program 

Pwlog.txt Besides brief overview on operations it also contains 
detailed information about the state of all hard disks 

Cdb.log Contains low-level information on the CD/DVD devices 
used in the system 

BioNTlog.txt 
or 
Bio95log.txt 

It is an OS-dependent supplementary log file derived from 
Bioxx.dll. It may contain valuable information on Windows 
family operating systems 

  

 

Log files do not contain any confidential information on the operating system settings or the 
user documents. 
  
The Send Log Files function is only available when outgoing mail server (SMTP) and the user 
e-mail address are properly set. To learn more about it please consult the Settings Overview 
chapter. 
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13 Glossary  
Active partition is a partition from which an x86-based computer starts up. The active partition must be a 
primary partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the 
system volume. 
In the DOS partitioning scheme, only Primary Partitions can be active due to limitations of the standard 
bootstrap. 
 
Backup Capsule is a specially secured place on the hard disk which is used to store backup images. The 
backup capsule has an independent system layout (e.g. a separate partition) and is even operable when the 
active file system is damaged. To avoid a removal or unauthorized access to the data, this partition is hidden 
and cannot be mounted in the operating system. The content of the backup capsule is only available for 
browsing when using special software. 
 
Backup Image is an archive of the disk, which includes all the on-disk files and service information on the 
disk layout. To restore disks from such an archive means retrieving all informational components of the disk 
(e.g. a hard disk image consists of its partitions, the Partition Table and even bootstrap code). 
 
Bootable Archives are created by adding a special bootable section when the user is backing up the data to 
CD/DVDs. The user is able to restore the data from these archives without having to run the program, but by 
simply booting from these CD/DVDs. 
 
Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by 
Windows organize hard disks based on clusters, which consist of one or more contiguous sectors. The 
smaller the cluster size, the more efficiently a disk stores information. If no cluster size is specified during 
formatting, Windows picks defaults based on the size of the volume. These defaults are selected to reduce 
the amount of space that is lost and the amount of fragmentation on the volume. A cluster is also called an 
allocation unit. 
 
Extended Partition is a type of partition that you can create only on basic master boot record (MBR) disks. 
Extended partitions are useful if you want to create more than four volumes on a basic MBR disk. Unlike 
primary partitions, you do not format an extended partition with a file system and then assign a drive letter 
to it. Instead, you create one or more logical drives within the extended partition. After you create a logical 
drive, you format it and assign it a drive letter. An MBR disk can have up to four primary partitions, or three 
primary partitions, one extended partition, and multiple logical drives. 
 
File system metadata. The servicing structures of a file system, which contain information about allocating 
files and directories, security information etc, are named file system metadata. File system metadata are 
invisible for users and ordinary applications because accidental modifications of the metadata usually make 
a partition unusable. 
 
Hard disk geometry. Traditionally, the usable space of a hard disk is logically divided into Cylinders, 
Cylinders are divided into Tracks (or Heads), and Tracks are divided into Sectors. 
 
The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named 
Hard Disk Geometry or C/H/S geometry. 
Tracks and Cylinders are enumerated from "0", while Sectors are enumerated beginning with "1". 
These disk parameters play an essential role in the DOS Partitioning scheme. The alignment of partitions 
takes the parameters of the hard disk geometry into consideration. 
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Modern hardware uses an advanced scheme for the linear addressing of Sectors, which assumes that all on-
disk sectors are continuously enumerated from “0”. To allow backward compatibility with older standards, 
modern hard disks can additionally emulate C/H/S geometry. 
 
Hidden partitions. The concept of hidden partitions was introduced in the IBM OS/2 Boot Manager. 
Operating systems do not mount "hidden" partitions, which prevents access to their contents. 
 
A method of hiding partitions consists in changing the Partition ID value that is saved in an appropriate 
entry of the Partition Table. This is achieved by XOR-ing the Partition ID with the 0x10 hexadecimal value. 
 
This method only works when the set of usable Partition ID values is very limited, since large sets of usable 
Partition IDs can lead to confusing file system types; for example, Ext2 partitions are marked with the 0x83 
Partition ID value. A hidden Ext2 partition would be marked with the 0x93 Partition ID value, which is 
identical with the Amoeba File system Partition ID. 
 
Magnetic Force Microscopy (MFM) is an effective tool to magnetic investigations on submicron scale. 
Image obtained by MFM is the space distribution of some parameter characterizing magnetic probe-sample 
interaction, i.e. interaction force, amplitude of vibrating magnetic probe, etc. The MFM technology can be 
successfully used to resurrect deleted information. 
 
Master File Table (MFT) is a relational database that consists of rows of file records and columns of file 
attributes. It contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is 
similar to a FAT table in a FAT file system. 
 
MBR & 1st track of the hard disk is the 0th sector of the disk. MBR (Master Boot Record) contains 
important information about the disk layout: 
- The partitioning scheme. 
- The starting records of the Partition Table. 
- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses). 
 
Generally, the 0th sector is used for similar purposes in all existing partitioning schemes. 
The capacity of the MBR is not sufficient to place sophisticated boot programs. This means that the on-boot 
software uses the entire 0th track of the hard disk in addition to the 0th sector because it is not included in 
any partition. For example, boot managing utilities such as LILO, GRUB and Paragon Boot Manager are 
located in the 0th track. 
 
Partition ID (or File system ID) is the identifier of a file system that is placed in the partition. The partition 
ID is used to quickly detect partitions of supported types. Some of the operating systems rely completely on 
the Partition ID when distinguishing supported partitions, while others again do not.  
The partition ID is saved in appropriate entries of the Partition Table. It takes up only 1 byte of space. 
 
Partition Label (sometimes also referred to as Volume Label) is a small textual field (up to 11 characters) 
that is located in the partition's boot sector. This value is used for notification purposes only. It is detectable 
by any partitioning tool including DOS' FDISK utility. 
 
Modern operating systems use other methods to save the Volume Label within the file system, e.g. as a 
special hidden file. The Volume Label is able to contain a relatively large amount of text in multiple 
languages. In general, the Volume Label and the Partition Label are rather different. 
 
Partitioning scheme is a set of rules, constraints and the format of on-disk structures that keep information 
of the partitions that are located on the hard disk. There are several partitioning schemes, which can be used. 
The most popular partitioning scheme is the so-called DOS partitioning scheme. It was introduced by IBM 
and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible computers. 
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Another popular partitioning scheme is the so-called LDM (Logical Disks Model) that originates from UNIX 
mainframe systems. The Veritas Executive accommodates the simplified version of LDM to the Windows 
2000 operating system. 
 
Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme 
and the new Dynamic Disk Management (DDM). The problem is that older versions of Windows do not 
support DDM. In addition, most hard disk utilities do not support it as well. 
 
Recovery Media is a CD or DVD (or even a floppy disk) from which the user can boot and recover the 
system. 
 
Root Directory is the top-level directory of a formatted logical drive. The Root Directory includes other 
files and directories. 
In modern file systems (e.g. Ext2/Ext3, FNTFS and even FAT32), the Root Directory does not differ from 
other directories in properties. This is not the case for old FAT12 and FAT16 file systems. 
 
Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a Serial Number, 
which consists of 32 bits and is represented by an 8-figure hexadecimal value.  
 
The hard disk's Serial Number is stored in the MBR. Its value is assigned when the MBR sector is initialized 
by standard disk managing tools from Microsoft, such as Windows Disk Administrator and FDISK utility.  
 
In fact, the hard disk's Serial Number is not important for most operating systems and software. It is known 
that Windows NT, 2000 and XP store hard disks’ Serial Number values in the database of assigned drive 
letters. 
 
A partition's Serial Number is stored in its Boot Sector (in FAT16, FAT32 and NFTS file systems). Its value 
is assigned when the partition is formatted. In fact, the partition's Serial Number does not play an important 
role for most operating systems and software. 


